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Synopsis :

Rainfall-Runoff-Inundation (RRI) Model simulates various hydrologic processes

including rainfall-runoff, stream flow propagation and flood inundation in an
integrated manner at a river basin scale. The model solves diffusive wave equations
applied to flows on ground surface and subsurface on the two dimensional basis.
The model is designed to be applicable even to large river basins with limited data
by utilizing satellite-based information. The model application includes flood
prediction and risk assessment, in particular at a basin with large floodplains. This
technical manual describes the basic concept with equations, step-by-step model
application and the advance use of the RRI model.
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1. Outline of Rainfall-Runoff-Inundation (RRI) Model

1.1 Model Structure Overview

Rainfall-Runoff-Inundation (RRI) model is a two-dimensional model capable of simulating
rainfall-runoff and flood inundation simultaneously (Sayama et al., 2012). The model deals
with slopes and river channels separately. At a grid cell in which a river channel is located,
the model assumes that both slope and river are positioned within the same grid cell. The
channel is discretized as a single line along its centerline of the overlying slope grid cell. The
flow on the slope grid cells is calculated with the 2D diffusive wave model, while the channel
flow i1s calculated with the 1D diffusive wave model. For better representations of
rainfall-runoff-inundation processes, the RRI model simulates also lateral subsurface flow,
vertical infiltration flow and surface flow. The lateral subsurface flow, which is typically
more important in mountainous regions, is treated in terms of the discharge-hydraulic
gradient relationship, which takes into account both saturated subsurface and surface flows.
On the other hand, the vertical infiltration flow is estimated by using the Green-Ampt model.
The flow interaction between the river channel and slope is estimated based on different

overflowing formulae, depending on water-level and levee-height conditions.

Schematic diagram of Rainfall-Runoff-Inundation (RRI) Model




1) Rainfall-runoff and inundation simultaneously with diffusion wave approximations.
2) Subsurface flow (lateral subsurface and vertical infiltration) is simulated for physical
representations of rainfall-runoff processes.

3) One-dimensional diffusive wave river routing and its interaction with the slope model.

1.2 Governing Equations of RRI Model

A method to calculate lateral flows on slope grid-cells is characterized as “a storage
cell-based inundation model" (e.g. Hunter et al. 2007). The model equations are derived
based on the following mass balance equation (1) and momentum equation (2) for gradually
varied unsteady flow.
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where A1is the height of water from the local surface, gx and g, are the unit width discharges

3

in x and y directions, u and v are the flow velocities in x and y directions, ris the rainfall
intensity, fis the infiltration rate, His the height of water from the datum, pw is the density
of water, g is the gravitational acceleration, and 7x and 7y are the shear stresses in x and y

directions. The second terms of the right side of (2) and (3) are calculated with the Manning’s

equation.
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where nis the Manning’s roughness parameter.

Under the diffusion wave approximation, inertia terms (the left side terms of (2) and (3)) are
neglected. Moreover, by separating x and y directions (i.e. ignoring v and u terms in

equations (2) and (3) respectively), the following equations are derived:
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where sgn is the signum function.

The RRI model spatially discretizes mass balance equation (1) as follows:

. - i i y
dh"! + >(l - xJ + - yl
dt AX Ay

where gx/, g,/ are x and y direction discharges from a grid cell at (z, 7).

=r—f" (8

By combining the equations of (6), (7) and (8), water depths and discharges are calculated at
each grid cell for each time step. One important difference between the RRI model and other
inundation models is that the former uses different forms of the discharge-hydraulic
gradient relationship, so that it can simulate both surface and subsurface flows with the
same algorithm. The RRI model replaces the equations (6) and (7) with the following
equations of (9) and (10), which were originally conceptualized by Ishihara and Takasao
(1962) and formulated with a single variable by Takasao and Shiiba (1976, 1988) based on
kinematic wave approximations. The first equations in (9) and (10) (A < @ describe the
saturated subsurface flow based on the Darcy law, while the second equations (d. < h)
describe the combination of the saturated subsurface flow and the surface flow. Note that for
the kinematic wave model, the hydraulic gradient is assumed to be equal to the topographic

slope, whereas the RRI model assumes the water surface slope as the hydraulic gradient.

oH

k= (h<d)
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where k» is the lateral saturated hydraulic conductivity and da is the soil depth times the

effective porosity.

Equations (11) and (12) can be also used to simulate the effect of unsaturated, saturated
subsurface flow and surface flow with the single variable of A (Tachikawa et al. 2004,
Sayama and McDonnell 2009 for English).
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Note that to assure the continuity of the discharge change when A= dum, the lateral hydraulic
conductivity in unsaturated zone (k=) can be computed by km = k. / 5, so that kn is no longer

the model parameter.

These stage-discharge relationship equations were originally developed to be applied to
humid forest areas with a high permeable soil layer, where a lateral subsurface flow is the
dominant runoff generation mechanism. On the other hand, for relatively flat areas, the
vertical infiltration process during the first period of rainfall has more impact on large-scale
flooding; therefore, the vertical infiltration can be treated as loss for event-based simulation.
Here we calculate infiltration loss # with the Green-Ampt infiltration model (Raws et al.,
1992).

f= k{1+ @} (13)

where kv is the vertical saturated hydraulic conductivity, ¢1is the soil porosity, #;is the initial
water volume content, Sris the suction at the vertical wetting front and Fis the cumulative

infiltration depth.

Typically for mountainous areas where lateral subsurface flow and saturated excess
overland flow dominate, the equations (9) and (10) (or (11) and (12)) can be used with setting
fequals to be zero. (Note that the equations (9) and (10) (or (11) and (12)) implicitly assume
that the vertical infiltration rate within the soil is infinity.) On the other hand, for plain
areas where infiltration excess overland flow dominates, the surface flow equations (6) and

(7) can be used with the consideration of vertical infiltration by equation (13). If the vertical
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infiltration fis set to be non-zero and the lateral subsurface equations are used instead of the

surface flow equation, the lateral subsurface water is infiltrated to bedrock by the rate of £

As one can see from the equations, the parameter values of ki, km and kv decide which
equations to be used; i.e. (6) and (7) are used when k. and kn are zero, (9) and (10) are used

when kn is zero, and (13) is inactivated when kv is zero.

1.3 One-dimensional River Routing Model

A one-dimensional diffusive wave model is applied to river grid cells. The geometry is
assumed to be rectangle, whose shapes are defined by width W, depth D and embankment
height He. When detailed geometry information is not available, the width and depth are

approximated by the following function of upstream contributing area A4 [km2].

W =C, A* (14)

D =C_ A% (15)

where Cw, Sw, Cp and Sp are geometry parameters. Here the units of Wand D are meters.

1.4 River and Slope Water Exchange

Water exchange between a slope grid cell and an overlying river grid cell is calculated at
each time step depending on the relationship among the levels of slope water, river water,
levee crown and ground. The figure below shows four different conditions. For each
condition, different overtopping formulae are applied to calculate the unit length discharge
from slope to river (gs:) or from river to slope (gxs), which are then multiplied by the length of
the river vector at each grid cell to calculate the total exchange flow rate (Iwasa and Inoue,
1982).




(a) When the river water level is lower than the ground level, gs is calculated by the

following step fall formula.

qsr = /ulhs B ghs (16)

where x; is the constant coefficient (=(2/3)3/2), and As is the water depth on a slope cell. As
far as the river water level is lower than the ground level, the same equation is used even for

the case with levees so that the slope water can flow into the river.

(b) When the river water level is higher than the ground level and both the river and slope
water levels are lower than the levee height, no water exchange is assumed between the

slope and river.

(c) When the river water level is higher than the levee crown and the slope water level, the
following formula is used to calculate overtopping flow g:s from river to slope.

u;h2gh, h, /b <2/3

s = (17)

w29 —h) h,/h >2/3

where uz and us are the constant coefficients (=0.35, 0.91), and A; is the difference between

the river water level and the levee crown.
(d) When the slope water level is higher than the levee height and the river water level, the
same formula as (17) is used to calculate overtopping flow gs- from slope to river. In this case,

h; is the elevation difference between the slope and the river, and Az is the elevation

difference between the river and the levee crown.

1.5 Numerical Scheme

To solve equations (8), (9) and (10), the fifth-order Runge-Kutta method with adaptive
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time-step control is applied. This method solves an ordinary differential equation by the
general fifth-order Runge-Kutta formula and estimates its error by an embedded forth-order
formula to control the time-step (Cash and Karp 1990, Press et al. 1992).

The general form of the fifth-order Runge-Kutta formula is

k, = Atf (t,h,)
k, = Atf (t +a,At, h, +b,k,)
(18)
ke = Atf (t +a,At, h, + bk, +--bks)
Ny = N+ CKy + C,K, +Coky +Cyk, + Cok + Cok +O(AL?)

while the embedded forth-order formula (Cash and Karp 1990) is
hoy=h + Tk +Ck, +CTkg + 0Tk, +C kg +C kg +0(A°)  (19)

By subtracting As+ minus A*:~+1, the error can be estimated by using k7 to ks as follows,

6

S=h,—h = Z(ci —c?)ki (20)

i-1

The constant values (a;, bij, ¢i, ¢i?) used in this study are the ones introduced by Cash and
Karp (1990). If Sexceeds a desired accuracy 84, A+ is recalculated with a smaller time step
(Atpost)-

%

Aty = max(o.%t
o

025
,O.5At] (21)

As described above, the RRI model calculates slopes, rivers and slope-river interactions.
Model users specify the time step for slope-river interaction Az, which is also used as an initial
time step for slope calculations. Since river calculations usually require smaller time steps
because of higher water velocities and depths, the model allows river calculations to proceed
independently with different time steps until the next river-slope calculation time step. The
initial time step for river calculation (4¢,) can be also specified by model users as the common

divisor of A¢. In this study, 4= 0.01, 4¢= 600 sec. and 4z = 60 sec. were used.
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2. Getting Started

There are essentially five steps to conduct RRI Model simulation.

1. Preparing topography data (Section 3)

2. Preparing input rainfall data (Section 4)

3. Preparing model condition files with parameter settings (Section 5)
4. Executing RRI Model. (Section 6)

5. Plotting output data (Section 7)

Among the five steps, only the essence of step 4 and 5 are described here with sample data of

the Solo River Basin (in 30 sec resolution) in Indonesia.

2.1 Compile

Unzip “RRI_1.4.1.zip” and save it on a working directory (e.g. C:/).
Open CUI environment where you can compile Fortran programs

(For Intel Fortran Users on Windows)
Start > Program - Intel(R) Software Development Tools = Intel(R) Fortran Compiler **

- Fortran Build Environment for Applications running on ...

Move current directory to “‘RRI/Model/”, then type “make_1_4_ 1.bat” and enter to create
“O_rri_1_4 1l.exe”. (Command “cd directory_ namé’ is used to enter the directory, “cd ../ is
used to move up one directory, and “dir” is used to list all files and directories in the current

directory. To move D directory, just type “D:” and enter)

Also type “makePostProsess.bat” and enter to create “calcHydro.exe” and “calcPeak.exe”,

which are used for post processing.

o«

Make sure if “O_rri_1_4_1.exe”, “calcHydro.exe” and “calcPeak.exe” are newly created.

Note: If Intel Fortran Compiler is not available on your PC, use another Fortran compiler (e.g.
gfortran) to compile. Although the performance is not guaranteed, using the precompiled
executable files (0_rri_1_4_1.exe) is an option (on 64 bit windows machine). In that case, run

the following redistribution patch program before running the RRI executable files:

(fetc/w_fcompxe_redist_msi_2011.10.325/w_fcompxe_redist_intel64_2011.10.325.msi)




2.2 Run RRI Model

Look at “RRI_Input.txt”, which is the control file of RRI Model. You can edit the control file to

change the simulation settings including input files and parameters.

RRI_Input_Format_Verl 4 1

RRI_Input.txt

Jinfile/solo30s/rain_solo_30s_gauge.dat
Jinfile/solo30s/adem_30s_solo.txt
Jinfile/solo30s/acc_30s_solo.txt
Jinfile/solo30s/adir_30s_solo.txt

0 # utm(1) or latlon(0)

1 # 4-direction (0), 8-direction(1)
360 # lasth

600 #dt

For example, L3 specifies the path to an input rainfall file and L4 — L6 specify the paths to
input topography files (dem, acc, and dir). See Section 4 for more details on the RRI_Input.txt
file.

Execute “0 rri 1 4 1.exe” to run RRI Model.

g -
&Y Intel(R) Composer XE 2011 Intel(R) 64 Visual Studio 2008 - 0_rri.exe |2

572010886798468E-002 loc : 61

U, 7 Jo U.0lUe+Ud UL 0UUE+UL 0. 183E+04 O_rri'exe

0.000E+00 0.18 | 0.680E+08

2E-002

Uu

0.000E+0Q0

900352863E-002 loc :
). 000E+00 0.000E+00

2160

Confirm the output files are successfully created inside the directory of “RRI/Model/out”. Note

N
]



that “hr_000001.out” represents the spatial distribution of river water depths in [m] at the
output time step 1. “hs_000001.out” and “qr_000001.out” represent those of slope water

depths in [m] and river discharge in [m3/s], respectively.

2.3 Post Analysis

2.3.1 Visualize Inundation Depth (./out/hs_***.out) with GNUPLOT

Run a GNUPLOT installation program “RRI/etc/gp463-win32-setup.exe” and install it onto
your PC. If the installation is successful, “gnuplot” folder is appeared under All programs of
windows. Choose “gnuplot 4.6” to run GNUPLOT.

Open “RRI/Model/hs.plt” with a text editor. It is a GNUPLOT script file to convert from the
simulation outputs (e.g. .Jout/hs_***.out) to gif files to visualize inundation depth

distributions.

set terminal gif medium size 672, 408 crop

set pm3d map
set palette defined (0.0 "gray", 1.5 "blue", 3 "green")

set xrange [0:]
set yrange [‘] reverse
set zrange [0] reverse

#set xrange [180:200]
#set yrange [435:455] reverse

set cbrange(0.:3]
set zrange[0.0:]

From RRI output (hs_***.out) to gif

set 0utput|"./hs/hs_OOOOOl.gif" |
splot |"./0ut/hs_000001.0ut" hlatrix t "000001 / 000096"

set output "./hs/hs_000002.gif"
splot "./Jout/hs_000002.out" matrix t "000002 / 000096"

set output "./hs/hs_000003.gif"
splot "./out/hs_000003.out" matrix t "000003 / 000096"

-
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
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|
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|
|
|
|
|
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Select “Open” on GNUPLOT Toolbar and open “/RRI/Model/hs.plt”, which is a script file to
create gif files from the RRI output (see above figure).

Look at “RRI/Model/hs” directory, where gif files are newly created. Check the created gif files

by preview.

gnu
File Plot Expressions Functions General Axes Chart Styles 3D Help
©# ReplGt (& Open 2 ChDir & Print & PrtSc ) Prev € Next & Options v
GNUPLOT
Yersion 4.6 patchlevel 3 last moth{ied April 2013 GNUPLOT
Build System: MS-Windows 32 bit
Copyright (C) 1986-1993, 1998,
Thomas Williams, Colin Kelley pmdy 2
gnuplot home: http://waw. grd
faa, bugs, etc: type "help FA(
immediate help:  type “help” (...,
Terminal type set to "wxt’ Lo -
znuplot> _ :;:)}M 3
Select “hs.plt”
| & m-19~F
' J;ms{lt): v |Defeuit(*pi) ¥
[ [ anzey ] u<© [+ | n:zt:u.]
! |

Right click and preview

i JD7ANF) REE) |R(V) Y-T) AT (H)

2, | @86 v RS(FEI3-—  HEl BFA-LTHETS  FLWIAILS- = . Al 0

M FRo My - T hs_000001.gif ‘ ihs ......

J sayama |88 hs_000003.gif ke hs_
|, Documents (& hs_000005. gif &=hs] I7A0U(F) v EORP) v BTFX—jLE) JFda(u) v L) -
J RRL (58 hs_000007.gif Sahs]
i SRETHTOEY, [§8 hs_000009.gif 5 hs ] . ;
8 share = [&hs_coo011.01f Eahs/ 608973 / BDODG
4 share-sayama (58 hs_000013.gif % hs | e
4 sayama_desk (SAYA_ 5 hs_000015.gif s hs]
L SEREERREXTOST | g he_000017.git s
B F20-F | [EEhs_cooo1s.gif s hs )
i SR [ hs_000021.gif s
[§ hs_000023.gif &hs]
W >IsY [ hs_000025.g1f s
) FFaA>b (5 hs_000027. gif b
B EsFr (5 hs_000020.gif s hs]
B e 5 hs_000031.gif 58 hs]
D Za-ses T ke anannn Skon
i > I hs_000001.gif =336 2012/11/128:35 B2
GIF A X—% A&d: 571 x 287 {FREH: 2




2.3.2 Compute hydrograph

Look at “RRI/Model/calcHydro.txt” (see more details “RRI/etc/calcHydro/00_readme.txt”)
L1 : [In] location file (e.g. ./infile/solo30s/location_30s_solo.txt)

: [In] RRI output file (e.g. .Jout/qr_*** txt)

L3 : [Out] hydrograph file (e.g. ./infile/solo30s/disc_Cepu.txt)

&
Lo

Execute “calcHydro.exe”.

r

calcHydro.exe

0.00789 !
0.04591 Jinfile/solo30s/disc_cepu.txt
0.08256
0.10557
0.12529
0.14543
0.24838
0.56375
69.88281
967.36834
11 1322.37727
12 1429.53330
13 1518.85970

=1 O Ot = W o

[
o

©

Visualize the created hydrograph file (e.g. “/infile/solo30s/disc_Cepu.txt”) by GNUPLOT.
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From GNUPLOT screen, open and select “hydrograph.plt”, which is a GNUPLOT script file
to plot hydrograph from the “disc_Cepu.txt”.

[lZ] Gnuplot (window id : 0) EAEIE
Hle#@aaaly?
2500 T T T T
. "disc_Cepu.txt”
2000 _____"\ =
1500 —
.l."
/
f
|II
1000 | —
500 || -
0 A 1 I I I I I I I
0 10 20 30 40 50 60 70 80 a0 100
-2.03509, 2005.45

2.3.3 Compute and visualize peak inundation depths

Look at “RRI/Model/calcPeak.txt” (see more details “RRI/etc/calcPeak/00_readme.txt”) and
edit the file if necessary.
L1 : [in] dem file
L2:[
L3 : [in] the number of output files
L4 :

in] output file (e.g. ./Jout/hs_***.out)
out] output peak inundation depth file (e.g. ./infile/solo30s/hpeak_30s_solo.txt)

Execute “calcPeak.exe”. Then the file “hpeak_30s_solo.txt” is created under /infile/solo30s/

ncols 336
Nrows 204

hpeak_30 lo.txt
xllcorner 110.2 peak_30s_solo.tx
yllcorner -8.3
cellsize 0.00833333333333

|

|

|

|

|

|

|

I NODATA value -9999
: -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999
1 ~9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999
: -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999
1 79999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999

|




Visualize the created “hpeak_30s_solo.txt” on ArcGIS by converting it from ASCII to Raster.

1) Start ArcGIS (Skip the following procedure if ArcGIS softwre is inaccessible. Consider
the use of GRASS GIS by following the instruction in 3.3)
2) From ArcToolbox - [Conversion Tools] < [To Raster] = [ASCII to Raster]

'rqiﬁ-ﬁup-h-mView- R — [=|Er| =)
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
DRBE& L EB x|/ 00 & -|ZEE [ioewn k) @l0-A-<(@wEueme -0 <87 uA-5-
REANQ R e E-U(K O L MaE KT i analyste| Layer: [T T e 2 e @ @y
Terrain Preprocessing » Terrain Morphelogy » Watershed Procassing » Attribute Tools » Network Tools » Aplitilities <% 2 @ =) 32 lgo A & Help =

Edtor=]| » M| 2 2 L1 5| IS Y o B

' ArcToolbox # x Table Of Contents 7 x -
& ArcToolbox H 0S8 E
7@ 3D Anzlyst Tools

b eedienlB Input: C\RRI\Model\infile\solo30s\hpeak_30s_solo.txt

1@ Conversion Tools
- From KML

) & From Raster ot ASC raster fila
ragier 1l
i1 & From WFs - FIF - e roik 306 s0h 1t [B'y
@ Metadata =]}
Oulput restr
| mW§TocAD ¢ SRRIP. RRIS 1ud) vhosek S0c a
To Col B
@& o Callada Qutpua data typa [cptional)
1 & To Coverage FLOAT

&1 To dBASE

18 To Geodetabese
[}

E

IR

1 & To KML
- & To Roster
#, ASCII to Raster
i =% DEM to Raster
# Feature to Raster
#,, Float to Raster
-, Point to Raster
#., Polygon to Raster
--#, Polyline to Raster
%' Raster To Other Formg
1 & To Shapefile
7@ Dotz Interoperability Tools |_|
' (i1-§ Data Management Tools =
- Editing Tools
| - @ Geoooding Tools
@@ Geostatistical Analyst Tools
§| M @ Linear Referending Tools
@ Multidimension Tools =

« in | » e & n ¢« m ’

467.665 202.395 Unknown Units

T = = = — = J

3) For the input data, select “hpeak_30s_solo.txt”. For the output raster, a user may use
“RRI/StudySite/solo30s/gis/hpeak_solo”.




e o mere
| Fle et vew Bookmarks inssrt Selecton Gesprocessng cusomzs windows belp

Ogds Bx|9>|b- 2 E@ g orwinge K & E (D v A - (%1015 Wdotic “ vB I U Av>o
CRCR G MR el LIMA S| TR oAnalyst: | ayer; Phpssk oo ClEawiZ S - 0@

=
Terrain Preprocessing - Terrain Morpholegy - Watershed Processing - Attribute Tools - Network Tools - ApUtilities- S, 2 e, <k 3z 23 @ B -~ Help B |

Editor-| » P | BN Y .
7

ArcToolbox % x Table Of Contents 3 x =
&) ArcToolbox [EHess A
& @ 30 Analyst Tools 98 Layas

& @ Analysis Toals I ook <olo
q - @ Cartography Tools
- @ Conversion Tools S
N & & Fromkme I
& F . . )
g oo Low:0 Right click here and select properties
- § Metadata
- & ToCAD
- & To Collade
- & To Coverage
- & To dBASE
@- & To Geodstabase
- § To KML
=& To Raster
#, ASCI] to Raster
#., DEM to Raster

--#,, Feature to Raster
#, Float to Raster
#., Point to Raster
-,

N - Polygon to Raster
“,, Polyline to Raster
J Raster To Other Formi
- & To Shapefile
& @ Dats Interoperability Tools  _ =
O — T @een < = »

110.091 -7.846 Deamal Degrees

4) Right click “hpeak_30s” and select properties to change the layer color setting.

| General | Source | Extent | Display | Symbology

Show: stretch values along a color ramp
Unique Values

Classified -
Discrete Color

Color Value Label
l PRI ich : <.25

Edit HighLow Value_[¥] D
0 L

ow:0

-
oo R >

[T Display Background Value:

[T]use hillshade effect 1 Display NoData as
Stretch

Type: ( Wlmﬁan@ V) Histograms

[invert

[ Apply Gamma Stretch:

ok ) [L®evtn ][ @E®

5) On the layer property, change the stretch type to “Minimum-Maximum” and change
Color Ramp if necessary. By checking “Edit High/Low Values”, you can change the max and
min value range of the stretching.




File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help

OBE& Lol x oo (e [ I EG [ orewingr k5 0 A -0 0] Udoe 0 s ulA-b-
CYCRAN* IR TIx (@7 E N R 30 Analyst - | Layer: [& hpeak_solo HIRsel28 - @@y

: Terrain Preprocessing - Terrain Morphology - Watershed Processing - Attribute Tools - Network Tools - ApUtilities- 5. 2 2@ - Helpi‘

L Editor-| b R | 2 oF £ 3| I M g

ArcToolbox 3 X Table of Contents ox
& ArcToolbox
89 3D Analyst Toals
-@ Analysis Tools
-§ cartography Tools
B Conversion Tools
& From KML
&, From Raster
& From WFS
-8 Metadata
& To CAD
& To Collada
& To Coverage
& To dBASE
-8 To Geodatabase
& TOKML
& To Raster
|- %, ASCII to Raster
i-#, DEM to Raster
i-#% Feature to Raster
1% Float to Raster
~#%, Point to Raster
i-#, Polygon to Raster
i %, Polyline to Raster
i & Raster To Other Formi
-8 To Shapefile
Data Interoperability Tools E|

i ' [@e|en « m v

Value
I High : 4.25

Low : 0

L

n

111.616 -5.972 Decimal Degrees
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This section shows the method to prepare topography data input to the RRI Model. The

topography data can be prepared by a user or downloaded from the website of USGS
HydroSHEDS, which is a global scale dataset offered by the United States Geological Survey

(USGS). The dataset includes elevation, flow direction and flow accumulation.

From the downloaded topographic dataset, a user must clip out the target river basin and
save them as ESRI/ASCII format files. Then using a program included in RRI Model package,
one adjusts the original DEM and flow direction data to be suitable for the RRI simulation.
The following chart shows the procedure descried in this section. In the previous section, the
30 second resolution of the Solo River Basin data was used, whereas this section presents how

to prepare the topographic data in 15 second.

The flow of the procedure is as follows.

[ Download HydroSHEDS dataset ]

v

[ Create a Point Shapefile to identify a catchment outlet ]

+

[ Delineate a target catchment with the outlet and flow direction information ]

v

[ Using the catchment raster, extract dem, dir and acc ]

v

[ Convert the dem, dir and acc to ASCII data ]

v

[ Adjust dem and dir for RRI simulation ]

3.1 Downloading HydroSHEDS Data

The following three types of topography data must be downloaded from HydroSHEDS

website for RRI simulation.

1) Elevation data
3 arc-second (about 90 m), 15 arc-second (about 500 m), and 30 arc-second (about 1,000
m ) are available.

2) Flow direction data

3-1



3 arc-second, 15 arc-second, and 30 arc-second are available.
3) Flow accumulation data
Only 15 arc-second and 30 arc-second are available. For 3 arc-second resolution, a user
must prepare a flow accumulation by using a GIS function [Spatial Analyst] =
[Hydrologyl = [Flow Accumulation].

% For detailed specifications of HydroSHEDS, refer to HydroSHEDS Technical

Documentation packaged with the downloaded data.

(D Access USGS HydroSHEDS website (http:/hydrosheds.cr.usgs.gov/index.php) from a
web browser and then select and click the DATADOWNLOAD button on the lower left.

| USGS HydroSHEDS =1

-

@ Select “15sec GRID: Conditioned DEM” and download “as_dem_15s_grid.zip” (207 MB)
for Asian region with 15 sec grid-size. NOTE that for 3 sec, recommend to choose
“Void-filled DEM”. For 15 sec and 30 sec, only “Conditioned DEM” is available, and they
are previously named as “Void-filled DEM”.

@ Select also “15 sec GRID: Flow Accumulation” and “15 sec Flow Direction” to download
“as_acc_15s_grid.zip” (132 MB) and “as_dir_15s_grid.zip” (64 MB) as well.

@ Unzip the three types of topography data downloaded.
% Folder naming rule
“Continental range” _ "Data type” _ “resolution”
e.g) as_acc_15s — Asia catchment area data 15 sec
as_dem_15s — Asia digital elevation data 15 sec
as_dir 15s — Asia flow direction data 15 sec
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3.2 Delineating HydroSHEDS Data using ArcGIS

(If ArcGIS is inaccessible, skip this section and go to 3.3 to use free GLASS GIS)

(D Start ArcMap, and read in the unzipped files by selecting [File] >[Add Datal. (Or use icon
of “Add Data” on the standard tool bar). Perform the same operation for all the three types
(dem, dir, acc) of topography data.

Q) 55 - ArcMap - Arcview

File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help

= Bx|o 177,461,384 -[:.! " Drawing~ & () @[~ A - 6] MS Ul Gathic: ~W ~-p 7 U A-dh D
®RAMO| k@ o 88 & 30 Analyst~ | Layer: [ as_dem_15s "Raal 2 Q@
! Terrain Preprocessing » Terrain Morphology » Watershed Processing = Attribute Tools  Network Tools » ApUtilities- ¥ 2 e, =f- s IR B ~# Help _
|
Editor - fx o "
ArcToolbox 2 x Table Of Contents 1 x -
i, Flow Length - 8BCE HE
<
H X‘ S £ Layers &
%, Snap Pour Point = as_dem_15s
- #5, Stream Link ValiE
+-*%, Stream Order High : 8454
#, Stream to Featur
H
", Watershed Low : 232
& Interpolation
& Local
& Map Algebra E 1 as acc 155
Value
[ & Math
& Multivariate Eighiz2353e19
& Neighborhood E
& Overlay howeci 4 =
& Raster Creation
&y Reclass B [ as_dir_15s
& Solar Radiation = m-1
& Surface mo
& Zonal m!
- Spatial Statistics Tools m?
& Analyzing Patterns | o4
&y Mapping Clusters ms
& Measuring Geograph mi6
» Modeling Spatial Rel:
m32
& Rendering e
? L{t\|ltle-5. - -1z 2
4 I, | 3 “[@e|en «f 1 | v

Switches to data view 60.731 4.633 Decimal Degrees

*Selecting the folder to connect
If the folder you need to connect is not displayed in the window, click “Connect to Folder” to

connect to the working folder.

Look in: [E as_dir_15s

@as_dir_lSs

MName:

Vi¥Users¥sayama

Show of type: | patasets and Layers




@ Display the flow accumulation data (i.e. as_acc_15s) on top screen (change the color range
to show river network clearly). Then find your target river and decide the rectangular

range, which covers all upstream contributing area. (At this stage, the following rectangle

range should be just written down on your notebook and no operation is necessary with
GIS.)

ks [msert  Selection  Geopmoessing  Customize Windows  Help
TEHES B x| o b | hnaten ] EEEE O w2y orawings K () 0= A - 07| dw ulGens W T g AR
S E[#e - MO DRI T oAt e B HEawiBB (0@
Terrnin Preprocsssing - Terrain Marphology - Watershed Prosessing - Attriute Tock = Netwark Tocls - ApUitilities- S & #, < 52 S 0 # Melp _

| =

File Edit View

Edtor- | -

ArcTolboe 8 x Tabis Of Conberts 3 x HIERIRY

i ArcTookon Bl :

i @ 30 Analyst Tooks ~ & Layers \
i @ Analysis Tools

|| & cartograpny Toos

« @ Conversion Tools

4 @ Data Inberoperabiiny To

+ @ Data Management Took
Y Eciting Tocks

4 G Gaccocing Tools

& Geestatisticnl Anayst T 4

+ ) Linanr Rafaransing Tosk Vohe s )

& G Multidimansion Teals High £ BUSI y P = Shr

£ M stk Annhyst Tocks = i

& ) Parcel Fabric Took Low 1-232 b < -‘

L

5 B asdem_154

Spatial Analyst Teols - { ’ 2 i
@ Conditanal ™1 " | vy i
-l Density m > = &,
- Distance m: 7y Fn

- Extraction = * i ) P g "'_fa.

#, Extract by Attrby i e ,.{f
. z ™ e ;
, Extract by Circle = ol ”

%, Extract by Mask
# Extract by Ponts . a
., Extract by Pobyga - 7‘_‘." i
o Extract by Rectar = %
., Extract Mdti vak) 2t w #
., Extract Values to ,"‘-a'..,_,_‘f Sogldy T L
“, Samgle Sy o
4 B Generalization &
41 B Grourchwaiter i IS,
+ B Hydrology E
Sy - Solo River Basin

s Mg Map Algebrn s

4t B Math 3
41 s Multhariats

4 B Naighbarhood

4 s Overiay

& B Raster Creation
o B Meclass

5 B Selar Radistion
-l Serface

g Refer to coordinate

= @) Spatal Stotwes Tosls ~ =
‘ W v el eu . m '

-6.6

110.2 e.g) Solo River 113.0

-8.3

(The range should be written down on your notebook.)

@ Show arc catalog (from the main menu, [Windows] = [Catalog]).
On the arc catalog, “Folder Connections” to a working folder (e.g. /RRI/StudySite/Solo15s/gis/)
and right click to choose New = Shapefile to create a point Shapefile (e.g. Outlet).




rCreate New Shapefile

-

2] = |

Name: [cJuﬂet

Feature Type: [Point

Spatial Reference

Description:

Unknown Coordinate System

<

[T]show Details

|” Coordinates will contain M values. Used to store route data.
|"| Coordinates will contain Z values. Used to store 3D data.

0K

Cancel

J |

]

® From the main menu [Customizel 2 [Toolbars] = [Editor]
On the Editor, choose [Start Editing], then Choose “Outlet” (the new Shapefile) to start
editting.

Fil S\ Iocach Geopr g Customize ind Help
6l 1. Start Edltlng 0,000 B =1 £ Drawing- K () | [+ A - 7% 6] M5 Ul Gohic Y0 B ulA->- El
1 - IR TR A @i 30 Analyst+  Layer: [@ 2s_dir_15s AEaal 2@ Qi‘
| Terrzin Preprocessing » Terrain Morphology » WWatershed Processing ~ Attribute Tocls- MetworkTools- pUtilities ~ 45, e Help
Editor=]1 > M| 2 & L1~ 3% Start Editing
ArcToolbox 2 x ;h:mowm;ldashmmwe venmdazalsseorfnldef 5| Catalog ax
=48 30 Analyst Tools - ug Q3 8 a; st e 2o E- &%
i+ @ Analysis Tools i s_dem_15s.vat S 3 <
- = (7 Layers 3D dr_tmvat Location: £ gis
s = [ —t @ (& MSOCache “ |
@ Conversion Tools . & &5 NaviOffice
=@ Dats Interoperability Tc| & a6.acc 156 & 3 PerfLogs
= @ Datz Management Tool: ¥ © B3 Perlos
@ Editing Tools oo+ 100 2. Choose “Outlet” to start = £ Frogram Flles |
i+ @ Geocoding Tools l @ E3 Program Files (x86)
) F
& Geostatistical Analyst T L gl . ® [ ProgramData
p-dpasrosasrsall Low: 1 editing the point coverage = 5 Pythen2s I
& @ Multidimension Tools g Ez’“et 1
i+ @ Network Analyst Tools 7 4 as_dem_13 - g M;el
=+ & Parcel Fabric Tools value = -
High : 843 ] = E3 Studysite
E': Schematics Tools . = E3 solo15s B |
=@ Server Tools Source Typ2 B B gis ‘
- @ Spatial Analyst Tools Low 233 || CamRIvShdySte¥sa 158 g Shapefiies / cBase Fles = @ acc_155_solo I
& Conditonal @ d sheds¥15:%...  Arcinfo & # acc_15s_wh |
B ‘ Density B as_dir_15s 3 c:¥soyamaYsatditedata¥hycrosheds¥152¥.,,  Arcinfo Workspace o g m_; SI;Wh r
B Distance - = _solo_15s
; : Extraction .01 r & # dir_solo_15s
h - P @ 4 dir_solo_15s2
i, Extract by Attriby 1 -
H - =) outlet.shp
#, Extract by Orcle =2 ] outlet.txt
‘\Extractb,fMask - o 88 wsd
i+, Extract by Points me = {5 wsd2 |
i+, Extract by Polyge e = § wsd_solo
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< 111 3 i » I
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Clicking “Outlet”, so that you can bring a point to indicate the target outlet.
After editting the outlet point, go to the editor menu to save and stop editing.
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® Using [ArcToolbox] = [Spatial Analyst Tools] < [Hydrologyl - [Watershed], delineate a
watershed with the defined outlet.

(IMPORTANT) To use [Spatial Analyst Tools] on ArcGIS, you must have the extension
and activate it by choosing [Cusomize] - [Extentions] & add a check for [Spatial
Analyst].

Input flow direction raster z—_‘l’as_djr_l 5s j
fas dir_i6s — =l &

t rast: feat int dat r . .
IoInpuUtb:as er or feature pour poin ‘a_a______, Outlet (i.e. a created point Shape file jﬁ @]

Pour point field (optional)
Id -

Output raster ﬂRI/StudySite/ solo15s/gis/wsd_solo_15s l

C¥RR¥StudySite¥solo 15s¥eis¥wed solo_15s

Environments

-

(IMPORTANT) Analysis range must be specified from the “environment” as below;




¥ Workspace
¥ Output Coordinates

A Processing Extent
Extent

) &

-6.600000

110200000 113.000000

-8.300000

[ K=

¥ XY Resolution and Tolerance

¥ M values

Processing Extent - As Specified Below -
¥ 2 values

¥ Geodatabase Then type in the range you decided in @

b Adv

¥ Fields
¥ Random Numbers

Fle Edt View Sockmurks Irsart Selection Geogrocestirg Customize Windows  belp
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1l oy check layer
3 High : 10000

¢ prsmemnsedl ' propertles
% @ Mukidmensior Tooks it ;

-«
@ Metwork Ansiyst Tooks e \
Q Poccut Faboe Tooks & sa_dem_tta 7
@ Schamatics Teols Vake
@ Server Tooks . High : 8454
@ Spatial Analys: Tooks I
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i G Deraity
& Distance @ as_dv 18
& evouon o
§ Gerershzaton -o
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Q:wubw ot
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“ Fow mi6
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.
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| General | Source | Extent | Display | Symbology | Fields | Joins & Relates|

Property Value
[=] Raster Information

P
Number of Bands 1
Cellsize (X, Y) 0.0041666667, 0.0041666667
Uncompressed Size 1.05MB
Format GRID
Source Type continuous
Pixel Type unsigned integer
Pixel Depth 8Bit

Data Source

Data Type: File System Raster

Folder: C:¥RRI¥StudySite¥solo 15s¥gis¥
Raster: wsd_solo_15s

) Lt ) [ #Ee

(@ Right click the created watershed raster (e.g. wsd_solo_15s) and check layer properties.
Under the “Source” tab, you can check “Columns and Rows”. This will be the number of
columns and rows for the topographic data used by RRI Model. If it exceeds more than 1000,

using coarser resolution data is recommended to use.

Using [Spatial Analyst Tools] 2 [Extract] 2 [Extract by Maskl, prepare dem (elevation),

acc (flow accumulation) and dir (flow direction) masked by the delineated watershed.

,:

Input raster
Ias_de m_15s

Input raster or feature mask data rWS d solo 15s j
— - _J

@ |
h std_so lo_15s ;] @]
Qutput raster

C¥RRI¥StudySite¥solo 16s¥gis¥dem_solo_30s @
dem_solo_15s, dir_solo_15s, acc_solo_15s |

Environments

__r-as_dem_15s, as_dir_15s, as_acc_15s

-

[ ok || cancel ||Environments... || <<Hdetelp |

(IMPORTANT) Analysis range must be specified from the “environment” the same as above.
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LTI

O R

Editor e

ArcTonibre 3 x [Tathe Of Conte. 3 x
+ § Data Htercoaabilty Tools JOG B .
 Layers
2 Outiet
» s
Ve
+ & Festures bl
+ G Fieds I
+ & Fie Geadatabase Low1d
+ § Geseral
+ & Gesershzstion LR
e o0
&l 2 2e_oce 15
& isue
# & Layers and Table Vews "'U‘ 1
: § Podage
- &§ Prejections ane Transformation tow:1
& Roster
o & Raster Catsiog 2 596 1
+ G Aaster Dotases waue
4 @ Raster Frocessieg gh - 4
Low : 23
2 s or 1%
-
-0
-
-
-e
i
-
& Sutypes L
+ & Table s
+ & Workspoce
@ Tdtg Tooks

Fle £t View Boskmais [mert Zelectior Ceopocessing Customize
~ 2

2ds Bx 0
.

e 10N
L

WA R

Terain Pregrocessing - Teain Mophology = Watershed Processing - Attrbute Tools + Network Tools » ApUtilties

Windows  Help

MBI RO = v?, Orawege k

5;, 30 Ansyst~ | Layer: [@

016 Lt Gome

“l eB I U A
Pawlli - Q@
Cd o 2BPL ~ iy

2.

N

Make sure the
same columns
and rows for all
the topo data

E

110.859 -8.172 Decimal Degrees

The above figure is the example of dem. The dir and acc must be also extracted in a same way.

@ Convert all the processed data (i.e. dem, dir, and acc) from ArcGIS Raster to ASCII, which
are input data files for RRI Model. Using [Conversion tooll - [Conversion from Raster] -
[Raster to ASCII], perform conversion from raster to ASCII for all the three types of

topography data.

Ihput raster

IO:¥ RREStudySite¥solo 15s¥gis¥dir_solo_15s
Qutput ASCII raster file

C¥RREStudySite¥solo 15s¥gis¥dir_solo_15s txt

The created ASCII data have the following format. Make sure once again all the three

datasets have the same numbers in “ncols” and “nrows”.




Nrows
xllcorner
yllcorner
cellsize

-9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999
-9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999
-9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999
-9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999

1
1
1
1
1
1
1
1 NODATA value
1
1
1
1
1
1
1

110.2

-8.3
0.004166666667
-9999

dir_solo_15s.txt

DEM data (dem)

Flow accumulation data (acc)

Flow direction data (dir)

3.3 Delineating HydroSHEDS Data using GLASS GIS (optional)

(If the HydroSHEDS data delineation is completed with ArcGIS, skip this section.)

@ Install the latest GRASS GIS (Latest GRASS in December 2013 is ver 6.4.3.)
(GRASS website: http://grass.osgeo.org/ ).

Choose project location and mapset

Project boaation
(projection/coordinate system)

Welcome to GRASS GIS 6.4.3
The world's leading open source GIS

Select an existng project baation and mapset
or defne a new location

GIS Data Directory:  Ci¥Usars¥0026353.CTIEFDocUuments¥grassdasa

(directores of GIS flas)

Browse
Manage
Define new lbcation
- U
\ | lecation wizard

Accessible mapsets

Indus2

demolocation 002653
Indus PERMANENT

-
Create new mapset
in selected locaton

Create mapset

Rename/delete selected
mapset or location

Rename mapset |

i |

[ J°F

Start GRASS

] [(#7.0@ ] (2200
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@ Input your location name (e.g. Solo) and Click next.

Define new GRASS Location J ot S|

Define GRASS Database and Location Name

GIS Data Dractory: C:!Usel#usemame"lDocuments&grassdata ( Browse
——
Projact Lnauon{Sob N

Location Titke:

Input your project location. |

—

| Click Next
/—

)| | <=5 ) i 00> 3| Fesd (0

@ Select “Select coordinate system parameters from a list” and “Latitude/longitude

(Pseudo-projection)” as a projection.

Define new Location

Choose method for creating a new location

["9" Select coordnate system parameters from z Ist ]

() Select EPSG code of spatial reference system

© Read projection and datum terms from a gaoreferenced data fle

© Read projecon and datum terms from a Well Known Text (WKT) .pn fie
) Specfy projecton and datum tems usng custom PRO).4 parameters

() Create a genercc Cartesan coordinate system (XY)

| Click Next |

Y=
a2 ) | [ <E @]l s (N) > ) I et (0

Define new GRASS Location

Choose projection

Projecton code: I

Search in descrption: | Q15

Code 4}  Description -
&abrd Laborde

bea Lambert Azimuthal Equal Area : .
ey Choose Latitude / Longitude l

=g Lamvee

=
Bk Laskowski

k¢ Lambert Conformal Conic

keac Lsmbert Egual Area Conic

Ee_os Lee Oblated Stersographic
| Latitude/Longitude (pseudo-projection)

loxm Loxmuthal Click Next

et Gnara nhinua far |l ANNGAT /_—
AL
AP H) | | <FBE S (0)

j—
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® Check “Datum with associated ellipsoid” and click “NEXT*.

Define new Location

Choose projection parameters

Select datum or elipsoid (next page)
| ® Datum wih assocated elipsog "1 Ellpsoid onfy
Enter parzmeters for Latiude/Lomaedg_( pseudo-projection) projection

Cental Paralel | 0.0

Central Mendan | 0.0

Click Next j
l; —

d )| | <EmEN hrrostn (©

® Select “WGS 1984 and as a geodetic datum and click “NEXT".

Define new GRASS Location LA ]

Specify geodetic datum

Datum code: wost

Search in description: Q =

Code 4+  Elipsond Descriotion .
d18 bessel Amersfoort
romed40  intemational Monte Mario
a0 bessel Rikets koordinatsystem 1980
542 krassovsky  Pulkovo 1942

Choose WGS 1984 I
};}ﬁck Next |

(2w | <2 N >] Pretn©]

SAD-62  sam6Q Pleass use samf9 nstead
sam69 sam69 South American Datum 1969
Sase fschro0m South Asa

tokyo bessel Tokyo

wgs?2 was72 WGS 1972

| wosea | Wes 1984

(@ Click “OK” on “Select datum transformation” window and click “FINISH” on Summary

window. (Select “Cancel” for default resolution setting).

X

Select from lst of datum transormations Define new GRASS Location

0
Do not apply any datum trans‘ormations Summary

Used In whole wgsg4 region
towgsg4-0.000,0.000,0.000

GRASS Database: C:¥Users¥002653.CTIE¥ Documents¥ grassdata
Default 3-Parameter Transfonmation (May not be optimum for older daty

Location Name:  Sok
Loczton Title:

Fevnk (€}

Projection: Latitude/Longitude (pssudo-projection), WGS 1984

PROJ.4 definidon: +proj=longit
(non-definiive)  +no_cefs
+a=6378137
+f=298.257223563
+towgs84=0.000,0.000,0.000
+datum=wgs84

| Click Finish |

Vv
& S oy,
a2 )| [ <Be) (et (©
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Click “Start GRASS” to start GRASS GIS.

L& Wielcome to GRASS GIS.

Welcome to GRASS GIS 6.4.3
The world's leading open source GIS

Select an existng project baation and mapset
or defne 3 new location

GIS Data Directory:  C:¥Usars¥002653.CTIE¥Documents¥grassdaa L Browse ]
Choose project location and mapset Mznage
Project boaation Accessible mapsets Define new hcation
(projaction/coordinate system) (directores of GIS flas) e r———
demolocation 002653

Create new mapset
Indus PERMANENT in selected locaton

Indus2 Crezte mapset
_ Rename/delete selected

mapset or location

Rename mapset x|

Click

< n ] v||« i 3

o statcrass > | [(#70@ ] [~z ]

@ Read in the unzipped files by selecting [File] >[Import raster datal] >[Common formats

import].
. o
Joctungs roster wector imogery volumes  Detobose  telp 5,;_,“‘”,,*5].:.;;‘;:8_,“} 24 lge 2vev v
Workspsce ol .
Map daplay Y
Impact racter dats J|  commonformate import [ringdal]
Import vector dsta Y ASCIL x,y.2 point import and gridding  [rinxyz]
Impoet 30 rester dota ' ASCII gnid import [rieasci]
Import database tavke X ASCIE polygons snd lines impeet  [en.poly]
Export raster map \ Binary file impot  [rinbin]
Export vector map k ESRI ASCHE gridimport  [cinarc]
Export 3D raster maps ’ GRIDATBFOR import [in.gnidatb]
Export datatase table g

Matiab 20 array import [tinmat]
Link external formats. ’ SPOT NDVT import  [iin.spotvgt] "

Manage maps and volumes » SRYM HCT impert  [rin.srtm]
Terro ASTER HEF import [chvoster]

Map type comversions. »
WHS imgort  [rin.wms)
Georectify
Unpack raster map  [runpack]
Graphical modeder J
Run model

NVIZ (requires Tcl/Tk)  [mviz)
30 image rendering  [m.nviz.image]
Bearing/distance to coordinates  [m.cogo)
Cartographic Compeser  [ps.map]

Launch script

Ext GUI CrlsQ N

| Map lvers| Cormand consok | Search module | Pythen shel
rin.gial -~ IMport raster dta into & GRASS map kayer usirg GOAL. 0:00:47.04W; 0:50:47.87N VM_ ates - ¥ Render

@ Select “Arc/Info ASCII Grid” from the “Format” list and select unzipped HydroSHEDS
raster file name (e.g. w001001.adf for dem). Input “Name for GRASS map (editable)” as

“as_dem_15s” for example and click Import.
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Sattings N —
Load settings: [ o[ mEE || am |

Saete Select Arc/Info ASCII Grid |

@ Fike () Direct:

Select unzipped “***.adf” file |

Source settngs

Fonmmatz | Arc/Info ASCI Gnd = I
File: |rassdata!ére_DLétas_dem_lSs_Dnd!as_den'\_]Ss!as_dem_]S#WIJOIUOI.adf] Browse

List of GDAL layers

Layar d  Layer name Name for GRASS map (edizable)
¥ w00100L.3df as_dem_155

Input raster file name

Optons

[ keep band numbers Instead of Lsing band color names

__ Extend region extents basad on new datasat

L Force Lat/Lon maps to fit into geographic coordinates (90N,S; 180E,W)
I Overrde projection (use location’s projection)

T alow output files to overwrite existng files
V| add imported layers nto yer trae
T Close dialog on finish

[.command dag | [ B (@) || [_impor_J]

@ Perform the same operation for all the three types (dem, dir, acc) of topography data.

@ After importing three types of topography data, check the layer and right click on it and
“select zoom to selected map(s)”, then the raster file will be displayed in the window. (the

following figure shows the example of “dem” display)

POVGRASS GIS Layer -
s [ gy whne, outem v oo o RS 2 idie B S0 e Bye -
HmIET R S YL T, T IV e
fy @i BH @
~ Display 1
¥ us_dr 1550002653 .

& Remove

¥, as_acc_1564 Rename

Change cpacty level J select l

Gheck [zoom toseiectaa mapie) )

Sat computationnl ragon from calactad mp(e)

Zoom to selected map(s) (ignore NULLS)

Set computational regon from selected map(s) (gnore NULLS)
Exvort

Set color table
Histogram
Urivariate raster statistics
Profile

Metadata

| Map layers| Comwrand console | Search module | Python shed
d_rast -0 map=as_dem_15sS002653 78:39:26.24E; 30:56:46.655 lmm », 17 Render
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@ To show the flow accumulation (acc) clearly, right-click the filename of “acc” and select

“Set color table”.

E® i » % uel

2 5300e e & 55 g @ (ew

lilt Settngs  Koster Vecior un-g-rvivd-n- Databose Help
=R R T T e e e
) mis BEHRD @O

© Displiy 1 |
¥ as_or_155_20002653

Chang: opaaty lewel

2Zoom to selected map(s)

Set computational region from selected map(s)

Zoom to selected map(s) (ignore NULLS)

Sat computational region from selected map(s) (igone NULLS)
Export

Set color table ]

HW

Univanate raster statistics

— Profile
|Maplayers Command o,

BLira 11:17.955 Coordnates - VRender
A’“ D - ==

@ Check “Logarithmic scaling” on “Colors” tab and select “Type of color map”. User can

select color table from several color tables. Following figure shows the example selecting

“wave” as “Type of color table”.

[ Loganthmic-absout In

© nesgameqsmten | Set Type of color map §
T— - ; vl e W omE ieie S5 [a e B o]

Path to rules fle (™" to read rules from stdin): (rules=name) ‘

or enter values Interacavely

(ot | [sizviema)..

(0] Ly 00 (2]

r.colors -g map-as_acc_15s@002653 color-wave

112:50:14.69€; 6:43:05.405 | Crordnates - [7Render

@ To set the delineation range, select [Settings] > [Region] > [Set Region].
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File Raster Vector Imagery \olumes Databzse Help fow i o [R5 ® L AT e i‘ “ e
T i - E L P R Ty r——

GRASS working environment
Map projections

Addons extensions

m] Comrmand console | Search module | Python shel
g.region -- Manages the mdnry definitions for the geographic region. 56:26:19.03E; 69:16:38.98N [cwdmm -] |V Render M

@ Input values for edges of the target area (coordinates) and set a file for adjusting region
cells to cleanly align with a raster map, then click “Run”.
(To decide your target area, display the flow accumulation data (i.e. as_acc_15s) on top
screen to find your target river. The set rectangle range must cover all upstream

contributing area.)

hic region.

 exstng [_Bounds [JResoumon | Effects | pmt | opuonal |
] Align regon to resoltion (default = align to bounds, works only for 2D resolution) @) 4

Adjust region cells to

Valug for the northemn adge (formet dd:mm:ss{N|S}): {n=valug)

value for the southern edge (format dd:mm:ss{n|S}): s=value cleanly align with this

Value for the eastern edge (format ddd:mm:ss{E|W}): (e=-value)} |=
Value for the western edge (format ddd:mm:ss{E|W}}: (w=valus}

Value for the top edge: (t=valus)

raster map > choose
one of the files

Value for the bottom edge: {b=value)}

Shrnk realon until it meets non-MULL dat fr A this raster map: (zoom=name}
Bp© ¢ ) [;ae=(c) A7 (H)

] Qos= dizbg on fnsh
g.region rast-as_dem_155_2@002653 n=-6.6 s=-8.3 e~113 w=110.2
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Right-click the filename of “dir” file and select “Set computational region from selected map(s)
(ignore NULLS)”. Perform the same operation for all the three types (dem, acc and dir) of
topography data.

File nn- Vector Imagery \olumes Ostabase Help
A= RRE R T L IV IU e e
iy B EEeaiad

nght Chck and Set computatmnal region
from selected map(s) (ignore NULLS)

Dispbay 1

z B

71 ®.a5_dem_1550202653 Rerome

1 ;2 acc 1550002653 | Sl 4
Properties
Zoem to selected map(s) }.
Set computationsl region from selected map(s)

Zoom to selected map
Set computationsl region from selected map(s) (igrore NULLS)

A &
B
‘% @;{ SR P

@ Only for flow direction, change category values (definition of river flow direction in DIR
file), from ESRI type (1, 2, 4, 8, 16, 32, 64, 128) to GRASS type (1,2, 3, 4, 5,6, 7, 8).
Select [Raster] > [Change category values and labels] > [reclassifyl: Select
“DIR_ESRI2GRASS.txt”, prepared in package (/RRI/etc), as “File containing reclass rules”

Buffer rasters  [rhuffer]
Concentriccircles [r.cirde]

Clowst ponts  [rdistance]

Mase [rmask]

Raster map calculstor  [nmapaak]
Nesghborhood anatysis »
Overay rasters »
Solar radiance and shadows >
Termin analysis »
Traesform features. »
Hydologic modeling

Landscape structure modeling

Landscape patch analysis

Wildfire mededing

Generate random colls | Redassify by size  [rrecdass amca)
Genzrate surfaces [ Resassity (rredass] ]

M' Interpolate surfaces Recode  [rrecoce]

»
»
»
.
[ change catigory values and labels [ Interactively edit category vales [drast.odt]
=
’
»

Creates 2 new map faver whose category values ara based upon 2 ;. Creates a naw mep leyer whose category vakies are based upon 3
N recassfiation of the categores n an exsting raster map laver. W rechssiication of the categonies i an exstng raster map Byer. ]
Command output Manual b ~ Regured | (Opbonal: | Cormmand output Manual

B I
Raster mep to be redassified: {input=name) T Allow output files to overwrte existhg fles (overwrke)
I as_or_15s2002653 ] IEI | verbosz module output {verbose)
. R ) ] Qulet r'nfldule output (quet)
as dr 15 2 ] E redass rules: (rules=name)
[swtoozssa CTIE¥DoCuments _ESRI2GRASS.OC ] Browse |

or enter values nteractvely
Select “DIR_ ESRI2GRASS txt”

| Click I oM
{tkle=string)
mE©] [ s | [2-©] [sszen) [BuaE )¢ _mn [z ]

¥ add created map(s) into byer tree V] Add ceated mep(s) into Imr tree
| Close diakbg on fnkh | Cios= dizlog on finsh
rreclass Input=as_dir_15s@002653 output=2as_dir_15s_2 rules=C:¥Usersy rreclass Inpi 5_dir_1 P _dir_15s_2 rules=C:¥Usersy
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@® User needs to know the coordinates of the outlet (long./lat.) of target river basin to clip.

Select “acc” file and perform 1, 2, 3 and 4 as shown in following figures.

g 452 X
Flle Settings Raster Vector Imagery Volumes Databass Help

38 8[abiB e Biee

7] ™. as_dr_15s_2@002653 3
[£] | ®.as_dr_15s@002653 3
[F] | ®. as_dem_15sgao2653
B2 & as acc 1550002653 [IE

1. Select “acc”.

m Command console  Search module | Python shel

[¥IRender

l|£12:41:55.23E; 7:08:09.625

Flle Settings Raster Vector Imagery Volumes Database ‘Hap
=R R e ye L I e ey
/B BRBEoe ]

| Cick here to show search module engine >> |

2_acc_152§0026€53|as_acc_1539002
112.635278|-7.064493| | 74406

112.635278|-7.064493| | 74406 1

4. User can get coordinates of the
outlet.
(Long. | Lat. | Flow accumulation®)

C 1

Output window Corrand prompt

[ Clear ” Save ] I Log file H Cear I| Stop

112:41:55.23€; 7:08:09.62S [¥]Render

Map fayers m‘ Search module  Python shell
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@ To create basin boundary, select the outlet of target river basin.

[Raster]>[Hydrologic modeling]>[Watershed basin creation (r.water.outlet)]

Flle Settngs | Raster | vector Imagery Volumes Database Help

imd
/B

Develop raster map
Menage colors
Query roster maps
Map type
Buffer rastars  [rbuffer]
Concentric cirdes  [raircle]
Closast points  [r.distance]
Mask [nmask]
Raster map caloulator  [rmaspealc]
Neighborhood znalysis »
Overlay rostars » <
Solar radiance and shadows b fthe:
»
»

>
»
»
»

| Cick here to sf

eastinglnor

=112, ¢
cc_152€C

Terrain analysis pcc_15s6C
Transform features

Hydrologic modaling )]
Landscape structure modeling »
! Landscape patch analysis

Wildfire modeling

B

Change category values and labels >
Generate random cells
Generate surfaces

[nterpolate surfaces » e

Rcc_153@C »

v a2 RES SO T sae B [ae B

Carve stream channels [r.carva]
Fill lake  [rlake]

Depressionless map and flowlines  [rfill.dir]
Flow accumulation  [rterraflow)

Flow lines [rflow]

Watershed analysis [rwatershed]
Watarshed subbasins [rbasins.fill]

in creation  [rwateroutlet

Report and statistics »

Groundwater modeling  [r.gwilow]

Coordnates v

¥|Render

‘a P oo F =

@ Select layer of “dir” file as “Name of input raster map” and input layer name of basin

boundary data in “Name of raster map to contain results”.

@ Input x-coordinate(long.) of the outlet in “The map E gird coordinates” and input
y-coordinate(lat.) of the outlet in “The map N grid coordinates” and click “Run”. Then,

basin boundary layer of target river basin will be shown.

'\ Watershed basin creation program.
Optional r’Command outout | Manual
Name of nput raster map:
[3s_d_155_2@002653 ]
Narme of raster to contzai results:

(& ] E|
The E gnd coordnates:

(1125635278 ]
m— J

) AT (H)

V] Add created map(s) into ayer tree
V| Cos= dizlog on fnsh

(dm'mf-str'no)

r.water.outlet drainage~as_dir_15s_2@002653 basin-dip easting—112.63%

L GF

fwy e K ge

Basin boundary of Target
river basin

112:42:48 93F; 7:34:45.125 [coordinates -

¥|Render
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| Clip target river basin by using basin boundary layer.

[Raster]>[Mask(r.mask)]

Develop raster map >
Manage colors. >
Query raster maps »
Map type conversions »
Buffer rasters  [rbuffer]
Concentric drcles [reircle]
Closest points  [r.distance]

Mask [rmask]

Raster map calculator  [rmapecalc]
Nelghborhood analysis

Overlay rasters

Solar radiance and shadows
Terrain analysis

Transform features

Hydrologic modeling
Landscape structure modeling
Landscape patch analysis
Wildfire modeling

3

- v v v -

v v v v

Change category values and labels >

Generate random cells »
Generate surfacas »
Interpolate surfoces L
Report and statistics L

-m Command consale | Search module |~ Python shel
r.mask -- Creates & MASK for limiting raster operation,

112:50:14.64E; 6:43:05.405

| Select basin boundary layer as “Raster map to use as MASK” and input “1” in “Category

values to use for MASK” on “Create” tab and click “Run”. Then, clipped target river basin

will be shown.

B o Y T Y e

] Create inverse MASK from specified ‘maskcats' lis= 0]

Raster map to use as MASK: input=string)
CDB002653 )|

Category values to usa for MASK (format: 12 3 thru 7 *): (maskets=strng)

’

r.mask input=clip@002653 maskcats=1

112:45:26.55E; 8:10:00.615 Coordinates » | MASK V! Render

Export the three layer data (dem, dir, acc).
[File]>[Export raster map]> >[ESRI ASCII grid export]
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L3
ta |

(e R ':EJ'

Workspace

Map display »
Import raster data » |
Import vector dats »
Import 3D raster data >
Import database table » o
| e
FXport raster map v Common export formats  [rout.gdal] .
EXAEYeCORmaN " ASCLI grid export  [rout.asal]
Bl " ASCII x,y,2 points export  [rout.xyz]
Export database table »
| ESRI ASCII grid export  [rout.arc]
e * | GRIDATE.FOR export _[rout.gridath]
Manags maps and volumes » Matiab 2D array export [rout.mat]
M YRS Crverions Y Raw binary array export  [rout.bin]
ity MPEG-1 export  [rout.mpeg]
Graphical modeler PNG export  [rout.png]
Run model PPM export  [rout.ppm]
NVIZ (raquires Td/Tk) [nviz] PPM from RGS export [rout,ppm3] f
3D image rendering [m.wizimage] O ey oyt y o pov]
TIFF export [rout.tiff]
Bearing/distance to coordinates [m.cogo) VRML export [routvrmi]
Cartographic Composer [ps.map] VTK export  [rout.vtk]
Launch soript Pack raster map  [npack]
Exit GUI ceri+Q
U ] Bl WWWWJ |
rout.arc -- Converts a raster map layer Into an ESRI ARCGRID file. 111:12:31.30E; 8:20:06.125 Coordinates > | MASK [¥Render

85 Select three layer data (dem, dir, acc) and input output file name in “Name for output
ARC-GRID map” and click “Run”.

68 Perform the same operation for all the three layers (dem, dir, acc).

= N
“g: rout.arc [roster, export] PN
\'& Converts a raster map &ysr into an ESRI ARCGRID fike.
~ {Required: | Optional | Commend output ] Manual 1
Name of input raster map: (input=name)
as_dir_15¢@002653 -
Name for output ARC-GRID map (use out=- for stdout): (output=name)
C:¥Users¥002653.CTIE¥as_dr_L5s_out.asc ] . Browss |

Output filename

= = - -~ - ;
B© ¢ fn ] [2-©] [aze]

r.out.arc input—as_dir_15s@002653 cutput—C:¥Users¥002653.CTIE¥as_dir

3.4 Upscaling the spatial resolutions of DEM, DIR and ACC (optional)

If a user needs to upscale the resolutions of the topography files (dem, dir and acc), one can
use a program called “/etc/scaleUp/scaleUp.f90”. By specifying a multiple factor for upscaling
the resolution, the program outputs new dem, dir and acc based on the original topography
files. For example, if the spatial resolutions of the topography files are 30 sec and the specified
multiple factor is 3, the program creates the topography files having 90 sec (30s x 3). The

following shows the procedure to use the program.
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D Prepare “/etc/scaleUp/scaleUp.txt” file:

Jdem_solo_30s.txt
input files

Jdir_solo_30s.txt

scaleUp.txt

1 |
1 |
1 |
1 .Jacc_solo_30s.txt 1
13 » multiple factor for upscaling :
|

1 |
1 |
1 |
1 |

Jdem_solo_90s.txt
Jdir_solo_90s.txt
Jacc_solo_90s.txt

output files

@ Execute “/etc/scaleUp/scaleUp.exe” and find the created three sets of the topographic
data indicated in L5, L6 and L7 in scaleUp.txt

3.5 DEM Data Adjustment

There are some hollows in the original HydroSHEDS elevation data. Some of them represent
actual topographic features, while some of them are caused due to the intrinsic characteristics
of DEM. For example, deep and narrow valley, in which a river flows, may be blocked by
surrounding topography because of the DEM resolution. In that case, the simulated water

depths and river discharges with the original DEM are unrealistic.

Therefore, the following DEM adjustment is always recommended to avoid the unrealistic
hollows in the original DEM. The provided program called demAdjust2 (RRI/etc/demAdjust2)
follows the flow direction of HydroSHEDS and remove all the negative slope along the flow
direction by carving and lifting the original DEM.

The algorithm of demAdjust2 is as follows;
1. Based on the flow direction, demAdjust2 finds upstream cells (i.e. cells with no inflow).
2. Among the detected upstream cells, searching order is determined from the total length of
the flow paths from each upstream cell to its most downstream cell.
3. Following the above decided order, demAdjust2 adjusts elevations based on the following
procedures.

1) The negative elevation is set to be zero.

2) Lifting: If a single cell is extremely low (likely as a noise error) compared to its upstream
and downstream cells, the cell’s elevation will be replaced by the same elevation as the
upstream cell. The parameter “lift” is used as the threshold to detect sudden drop and its

default value is set to be 500 m.
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3) Carving: If the elevation suddenly increases along the flow direction, the cell’s elevation
will be replaced by the same elevation as the upstream cell. The parameter “carve” is used as
the threshold to detect the sudden increase and its default value is 5 m.

4) Lifting and Carving: By searching from the most upstream, it finds a cell whose
downstream elevation is higher than that cell (point L). By searching from point L toward
downstream, it finds a cell whose downstream is lower than that cell (point H). The point L is

lifted and point H is carved by the parameter “increment”, whose default is 0.01 m.
The demAdjust2 program conducts each of the above procedure repeatedly for each flow path
ways from all the detected upstream cells until all negative slopes are removed. Note that the

above procedure does not change flow direction.

Run demAdjustment2 program in /RRI/etc/demAdjust2.

The process is necessary even if a user would like to use original dem data. “demAdjust2”
program modifies not only “dem” data but also flow direction data “dir”. The modified “dir”
(named as “adir”) has flow direction equals to zero at outlet cells. This operation must be
done and “adir” always must be used for RRI simulation. Also note that there is no

correction for “acc”, so use the original “acc” regardless the demAdjust2 procedure.

Read the adjusted dem and dir data to ArcGIS to visualize the data.
Select [ArcToolBox] > [Conversion tool] >[Conversion from raster] >[ASCII—Raster].

”» b1

“adem”, “adir”, “acc” are the three important topography data for the RRI simulation.

3-23



4. Preparing Input Rainfall Data

This section explains the method to prepare rainfall data for RRI Model. A user can prepare

the data by any method as far as it follows a specified data format. Currently three program

sets are prepared for processing:

1) gauged rainfall with Thiessen polygon interpolation (/etc/rainThiessen),
2) GSMaP satellite based rainfall (/etc/GSMaP) and
3) 3B42RT (/etc/3B42RT) satellite based rainfall.

41

Prepare Input Rainfall Data from Gauged Rainfall Records

To use ground gauged data for creating input rainfall for the RRI simulation, one can use

/RRI/etc/rainThiessen/rainThiessen.f90 program.

(D First, prepare rain gauge data in Excel (e.g. gauge_solo_1d.xlsx).

[Z] 1™ =02 0_10.x icrosoft
B .| FA RS9 B 75 BR Bm SALDIITL  Acbat
: i MS PTSuh S TR A =rs EE - O g WA~ | 2

P e v A E iv B o . .

it BIO-|lz=- & AE = Ho 9 1/Lat1tude and longitude of
— — = : the rain gauges
— %lj umber of rain gauges I

A 1 J M N

1 125

2 lat -7.1845 -712661 -70B353 -722067 -72486 -5098 -723782 -7.24462 -7.15858 -714B15 -7.251%1 -9598 717517

3 |Inn I 111854 1121116 1115484 1111062 11138431 -5095 1115085 1113725 1120301 1119285 111.4876 -3598 1120516

4 o o [a} o o [a] [ [} ul [a} 0 o al [a}

5 86400 15 5 14 o 2 2 [ ul [a} 0 o 2 3

[} 172800 40 52 42 BS A1 30 65 a8 58 70 48 4

7 258200 o o [a] [ [} ul [a} [} 16 ul [a}

a 345600 14 i) 5 8 1] 3 [u] o 1" 5 [u]

9 432000 o — — L L 7 =] Q R . nf ll d

10 £18400 9 . . 0 v} Q

T8 coio00 15 [ Time step of the data in second ) s [ ar ;‘] ata [ ]
12 691200 0 - . . 0 0 q or m

| 7| (Note: start from zero) 2 2 g . mJ h
12 Bosoon °| The data is not necessary to be | ° o 0 regardless the time
15 950400 ] 25 2 20 .

16 | 1036800 s | _in constant intervals 0 0 0 interval

17 | 1123200 0 0 Q q

18 1208500 42 4] 2 o 0] Q 10 o ] q Q

18 | 1296000 B g 37 3 S 22 4] 6 12 30 ] 40 15

20 < >

Number of rain gauges

Set any negative value (e.g. -999) for missing data, not to be used for the interpolation.

@ Select all cells having values, and copy and paste on a text editor. Then save it as txt file

®

(e.g. gauge_solo_1d.txt)

Edit the input file “rainThiessen.txt” as follows.
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.Jsolo/gauge_solo_1d.txt ﬁ rainfall data prepared above ] :
24

Jsolo/rain_solo_gauge_30s.dat Divide parameter )
Jsolo/gauge_map_solo_30s.txt set 1 if the input rain data is in [mm/h],

ncols 336 set 24 if it is in [mm/d] _
nrows 204 Output file names Y
x11110.2 L3 : output rainfall (i.e. input for RRI) [mm/h]

yll -8.3 L4 : output map file (to check the spatial

cellsize 0.0083333333333333

Coordinate specifications of the output rainfall file. One can
copy and paste the header of a topographic file (i.e. dem).

However any coordinates values and cellsize can be specified
as far as the same coordinate is set in “RRI_Input.txt” and the
range covers an entire domain. See the detail in Section 8.2.

distribution of rain gauges) -
1
1
1
1
|
1
1
1
|
J

@ Run rainThiessen program.
® The created output file (e.g. “rain_solo_30s_gauge.dat”’) can be copied to
/RRI/Model/input/ and used as the input rainfall.

4.2 Prepare Input Rainfall Data from GSMaP

A9 A1 NAawnl -‘,:,-" CQMab ata
. L. JOWT ad GolVie palte

@D Open the following GSMaP web site with a web browser, and click on the link to the
GSMaP Data Archive Center.

GSMaP: lobal “atellite "=pping of
recipitation

IOverviewof GSMaP l Overview of GSMaP

Looking at GSMaP . Updated June 2009
Movies and Images Chck hel‘e

Thi ide to view and use GSMaP
GSMaP Data Archive (Gl ellite Mapping of Precipitation) product,
Center —

-1
About GSMaP and 1
Satellite Data 1

________ 1
I Publications
I Related Links
I Japanese Ver.

a. About GSMaP
The GSMaP project was promoted for a study "Production of a

(http://sharaku.eorc jaxa.jp/GSMaP_crest/index.html)

@ Click on “GSMaP_MVEK+” as the data to be downloaded.




GSMaP: lobal “atellite V= pping of
“recipitation

I Overvicw of CSHAP I GSMaP Data Archive Center

GSMaP Standard version

Looking at GSMaP
Movies and Images GSMaP_MVK+ (Product by the MWR-GEO IR combined

i algorithm with NOAA AMSU-B products
GSMaP Data Archive (Data period : 2003-2006)
e gdac/doc/GSMaP_MVK+_e.html

About GSMaP and

Satellite Data GSMaP_MVK (Product by the MWR-GEO IR combined

e algorithm)

IPuincntions (Data period : 2003-2006)

adac/doc/GSMaP_MVK_e.html

Iﬂela[edu“kS ez p— :
GSMaP_MWR+ (Retrievals from six satelliteborne

IJapa"ese Ver. microwave radiometers with NOAA AMSU-B products)

(Data period : 2003-2006)
gdac/doc/more.html#G

Then choose hourly or daily rainfall data to download. Note that this link allows you to
download the data only between 2003 and 2006. For the data after 2006, you must register
through the same website to obtain the password and download GSMaP NRT product.

To calculate the suitable range for the delineation, /etc/GSMaP/calc_area/calc_area.f90
program can be used. Before using /etc/GSMaP/calc_area.f90 program, the following “ncols” to
“cellsize” must be specified in the “calc_area.txt” suitable for the target catchment. These

parameters can be found from the headers of topographic files of “dem”, “acc” or“dir” prepared

for the target catchment.

Note: The spatial resolutions of original GSMaP are different between hourly (0.1 deg) and
daily (0.25) data. Please choose appropriate “cell_size_rain” specified in “calc_area.f90” before

running the program. Remember to compile the program if it is changed.

After running the program, the following information can be obtained and also output to

“out_by_calc_area.txt”.
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xll : 110.2000

out_by_calc_area.txt

|

1 yll : -8.300000

xur 113.0000

I yur : -6.600000

1

: xll_rain : 110.1250

I yll_rain : -8.375000

: Xur_rain : 113.1250

I yur_rain : -6.375000 Information that is necessary to
|

delineate GSMaP
o — o mmmmm o l;&ft, ibottom, iright, itop)

I
i :
I ?b.ottom ‘ 273 1 Rainfall location information to
i jright - 452 be specified in the RRI_Input.txt
I
I

::_itop 265 (xllcorner, yllcorner, cellsize)

|

I, xlicorner_rain (raster) 110.0000 |

:: yllcorner_rain (raster) : -8.500000 :

ncellsize rain _ _ _ _ ___ =~ _ - -0:25000001

L o L L L L L L L e e e e = = 4

4.2.3 Delineating GSMaP Data for Target Area

(D First, save GSMaP rainfall data in a folder (e.g. infile).
@ Execute the bat file “/etc/GSMaP/makeList.bat” to prepare a file list named as "list.txt”

dir /b infile > list.bat

Revise the pass, then
save and execute.

When executed,
[list.txt] is created

@ After revising the following, compile and execute [read_GSMaP_0.1deg.f90.]
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! Read GSMaP binary data and convert it to ASCII format,
! which can be read by RRI Model
!

! list.txt file must be prepared in advance by using make.bat
!

character*256 listfile read_GSMaP_0.1deg.f90
parameter( listfile = "list.txt" )

! input folder

. . Designate the path of the
character'zse nfilel e | Ptz fgpa et e ]
:_parameter(inﬁlel =" /infile/" ) :

character*256 cutfilel, cutfile
parameter( cutfilel = " /cutfile/" )

character*256 rainfile

parameter( rainfile = "rain.data" ) .
character*256 sumfile Running the program creates
parameter( sumfile = "sumRain.data" ) “rain.data”, which is rainfall

input file for RRI simulation

T

! Target Area 5D G AL RO TAD BED 2o 7
integer jleft, ibottom, jright, itop

! The range to delineate
! The values can be calculated by calc_area.f90 progray # g i |
! for a target catchment
parameter(jleft =440)
Parameter( ibottom = 273 )
I parameter(jright =452)
! Iparameter( itop

4.3 Prepare Input Rainfall Data from 3B42RT

Designate the
delineation
range from
calcArea.exe

(D Access the following FTP site for downloading 3B42RT data
ftp://trmmopen.gsfc.nasa.gov/pub/merged

@ Download "3B42RT.20%**** 7R2 bin.gz" files from the FTP site and save them
under ./etc/3B42RT/read/infile/

To calculate the suitable range for the delineation, /etc/3B42RT/calc_area.f90 program can be

used. See details in 4.2.2, the same process is used for GSMaP data extraction.




4.3.3 Delineating 3B42RT Data for Target Area

D The following process uses “bash script”. Windows users may install “clink” program to
run bash scripts (*.sh) on windows command prompt. The “clink” program can be
downloaded from: http://code.google.com/p/clink/

@ To calculate the suitable range for the delineation, /etc/3B42RT/calc_area.f90 program
can be used. See details in 4.2.2 because the same process is applied also to GSMaP data
extraction.

@ Execute "bash unzip.sh" in /etc/3B42RT/read/ to unzip the downloaded files
under ./etc/3B42RT/read/infile.

@ Edit "read_rt_file.sh" file to set extraction range in L4 to L7 (jleft, ibottom, jright, itop)
suggested by calc_area.f90.

® Execute "bash read_rt_file.sh" to extract data
Note: the extract does not run if the same output files already exist

® Edit "combine.sh" by setting the extraction range in L4 to L7 (jleft, ibottom, jright, itop)
suggested by "out_by_calc_area.txt", and set output file name on L9. Also edit L14, L17
and L20 to indicate which year, month and day of the data should be processed.

(@ Execute "bash ./combine.sh" to combine all rainfall files to create the RRI input, so that
the rainfall file, which can be read by the RRI program, will be created.

4.4 Format of Input Rainfall Data for RRI Model

Here is the format of the input rainfall data used for RRI Model. By specifying the cell size,
xll_corner and yll_corner of the rainfall data into a control file of RRI model G.e.
“RRI_Input.txt”), the model can overlay the rainfall distribution even if the ranges and the
resolutions are different from topographic data as far as the rainfall data covers all the

simulation extent.
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SLD RED TRQ RED oD BEO o0 R Ie
D@E-Hd oo |6 BosES oﬂﬁumber of XY grids | . e e

In |u mz,, e 113- bwul's | — ITGEEn i3
1 L 4 ol a2
2|g 0.56  0.30  1.T8 o pani fesd o4 0.00 0.00 0,00 0.00 0,00 0,00 O0.00 0.00 0,00 O0.00 0.00 0,00 O0.00 0,18 0,44 O0.48 0.26
$ 0.40  0.75  0.91 0.72  0.31 0.00 0.00 0.00 0.00 0.00 0.00 p.00 0.00 0.00 0.00 O0.00 0.00 D0.00 0.00 0.12 0.27 0.29 Q.18
0.15 n.an 0.a7 0.26 n.on 0,00 0.00 n.on 0.00 0.00 n.0n 0.00 o.0n n.on 0.00 0.00 n.on 0.00 o.00 0.00 0,00 0.00 0.00
w 0.00 0.00 D.00 0.00 0.00 D0.00 Q.00 0.00 D0.00 Q.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 D0.00 0.00 0.00 0.00 0.00 0.00
0.0 0.0n 0.00 0.0n 0.0n 0,00 0.00 0.0n 0.00 0.00 0.on 0,00 o.0n n.on 0,00 .00 n.on 0.00 0.00 0.00 0,00 0.00 0.0n
. 0.00 0,00 0,00 0.00 0,00 0,00 .00 0.00 0,00 0,00 0,00 0.00 0.00 0.00 0.00 0.00 0.00 D0.00 O0.00 0.00 0.00 0.00 0.00
0.o00 0.00 0.00 0.00 0.00 0.00  0.00 0.00 0.00 0.00 0.00 0.00 .00 0.00 0.00 o.0o0 0.00 0.00 .00 0.00 0.00 0.00 0.00
0.00 0,00 0,00 Q.00 0,00 0,00 Q.00 0,00 0,00 0,00 0.00 0,00 0,00 0.00 0,00 0.00 0,00 0,00 Q.00 0,00 0,00 Q.00 Q.00
>-1 0.oo 0.00 0.00 0.00 0.00 0.00  0.00 0.00 0.00 0.00 0.00 0.00 o.o0 0.00 0.00 .00 0.00 0.00 .00 0.00 0.00 0.00 0.00
Gy 0.00 0,00 D0.00 .00 0.00 0,00 .00 0.00 0,00 0.00 0,00 0,00 0.00 0.00 0.00 O0.00 0.00 D0.00 0.00 0.00 0,00 0.00 0.00
(] 0.00  0.00  D.00 0.00  0.00 0,00 0.00 000 0,00 0.00  0.00 0,00 0.00 0.00 0.00 O0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
~ g.00 0,00 0,00 g.00 o0.00 0,00 O0.00 0.00 0,00 O0.00 0.00 p.00 0,00 0.00 0,00 O0.00 0.00 0,00 O0.00 0.00 0,00 0.00 0.0
0.00 0.00 D.00 0.00 0.00 D0.00 0.00 0.00 0.00 Q.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 D0.00 0.00 0.00 D0.00 0.00 0.00
,.8 .00 n.on 0.00 0.0n 0n.on 0,00 0.00 0.0n 0,00 0.00 0n.on n.00 o.0n n.on 0,00 .00 n.on 0.00 o0.00 0.00 0.00 0.00 0.0n
g .00 0.00 D.00 Q.00 0.00 0,00 Q.00 0,00 0,00 Q.00 0.00 0.00 0,00 0.00 0.0 0.00 0.00 0,00 Q.00 0.00 0,00 Q.00 Q.00
o.o0 0.00 n.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 n.0o o.00 0.00 0.00 o0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
0.00 0,00 D0.00 0.00 0.00 D0.00 Q.00 0.00 0,00 Q.00 0.00 0,00 0.00 0.00 0.00 O0.00 0.00 D0.00 0.00 0.00 0,00 0.00 0.00
z (pObem wepldm 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 o.o00 0.00 0.00 o.00 0.00 [I.l]U’U oo 0.00 0.00 o.00 0.00
4y 2500 26 18+
21 - SI 1.488 0.5 0.00 0.00 0.00 0.00 0.00 0.00 N 0.00 0.00 D0.00° O0.00 0.00 0.00 0.00 0.00
22 1.27 | 5 0.12 0.0 0, 0.00 0.00 0.00 Number OfX grlds a0.00 0.00 0,00 .00 0.00 0,00 .00 0.00
23 0. 0. 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
24 0.0 0. 0.0n 0.00 0.00 LIy LI Lruy T.00 .00 n.on 0.00 o.00 0.00 0,00 0.00 0.0n
25 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 D0.00 0.00 0.00
26 0.0n 0.00 0.00 0.on 0.00 o.0n n.on 0,00 0.00 n.on 0.00 0.00 0.00 0.00 0.00 0.0n
27 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 D0.00 0.00 0.00 0.00 0.00 0.00
2 0.00 0.00 0.00 0.00 0.00 0.00 0.00 D0.00 O0.00 0.00 D0.00 O0.00 0.00 0.00 0.00 0.00
29 0.00 0.00 Q.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 D0.00 0.00 0.00 0.00 0.00 0.00
g0 0.00 0.00 0.00 0.00 0.00 o.o0 0.00 0.00 o.0o0 0.00 0.00 .00 0.00 0.00 0.0 0.00
31 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
32 0.00 0.00 0.00 0.00 0.00 .00 0.00 0.00 .00 0.00 0.00 .00 0.00 0.00 0.00 0.00
33 0.00 0,00 0.00 0.00 0,00 0,00 0.00 0,00 O0.00 0.00 0,00 0,00 0.00 0,00 0.00 0.00
34 0.00 0.00 0.00 0.00 p.00 0.00 0.00 0.00 O0.00 0.00 D0.00 0.00 0.00 D0.00 0.00 0.00
a5 n.on 0,00 0.00 n.o0n 0.00 o.0n n.on 0,00 o.00 n.on 0.00 0.00 0.00 0,00 o.n0 0.0
36 0.00 D0.00 Q.00 0.00 0.00 0.00 0.00 0.00 O0.00 0.00 D0.00 0.00 0.00 0.00 0.00 0.00
ar n.on 0,00 0.00 n.on 0,00 o.0n n.on 0,00 o0.00 n.on 0,00 o0.00 0.00 0.00 0.00 0.0n
3% 0.00 0.00 Q.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 D0.00 0.00 0.00 D0.00 0.00 0.00
EE]
a0 0.00 0.00 0.00 o0.00 0,00 0.00 0.00 0,00 O0.00 0.00 0,00 O0.00 0.00 0.00 Q.00 0.00
41 0.00 0.00 0.00 0.00 0.00 .00 0.00 0.00 o.oo0 .00 0.00 o.00 0.00 0.00 o.00 0.00
12 0.00 0.00 Q.00 0.00 0,00 0.00 0.00 0.00 O0.00 0.00 D0.00 0.00 0.00 0,00 0.00 0.00
43 0.00 0.00 0.00 0.00 pD.00 0.00 0.00 0.00 O0.00 0.00 D0.00 O0.00 0.00 0.00 0.00 0.00
a4 000 0,00 0,00 0,00 p.,00 0.00 0.00 0,00 O0.00 0.00 0,00 O0.00 0.00 0,00 0.00 0.00
a5 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 D0.00 0.00 0.00 D0.00 0.00 0.00
a5 0.0n 0.00 0.00 0.on 0,00 o.nn n.on 0,00 .00 n.on 0.00 0.00 0.00 0.00 0.00 0.0n
a7 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 Q.00 0.00
a8 0.0n 0.00 0.00 0.on 0.00 o.0n n.on 0.00 o.00 n.on 0.00 0.00 0.00 0,00 0.00 0.0n
[m === m e e e e m e e mmmmmeemmmmmmmmmmmmmeeemmmmmmm———————-
. . . . I
1% The input unit of rainfall must be always mm/hr regardless the data interval. i
1
I
I . . .
2% The time interval is not necessary to be constant. :
1
. . ~- . . . - 1
:X Rainfall between 3600 and 7200 is written under the time stamp of 7200 I
1
1 . . .
| (ust like rain gauge data). '

[RRI Input.txt] * * * Control file of the RRI Model

: RRI_Input_Format_Verl 4 1 1I
1 RRI Input.txt :
I /infile/solo30s/rain_solo_30s_gauge.dat 1
: Jinfile/solo30s/adem_solo_30s.txt :
1 ./infile/solo30s/acc_solo_30s.txt I
: Jinfile/solo30s/adir_solo_30s.txt 1
! l
: 0 # utm(1) or latlon(0) |
1 1 # 4-direction (0), 8-direction(1) :
1 360 # lasth
: 600 #dt Coord_inates and gri(% size of the
1 60 4 dt_riv south-west end of the rainfall data range
P26 Foutnum T !
i 110.2d0 # xllcorner_rain : :
-8.3d0 # yllcorner_rain 1 |
| 00083538340 0.00838333d0 _  celsze i | |
S |
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4.5 Calculation of Catchment Average Rainfall

To calculate catchment average rainfall from the input rainfall data, a user can use
“Jetc/rainBasin.f90” program. To run the program, “rainBasin.txt” must be prepared in the

following way.

1 ../../.Model/infile/solo30s/rain_solo_30s_gauge.dat
: ..I../.Model/infile/solo30s/dem_solo_30s.txt

; 110.2d0

1 -8.3d0

: 0.00833333d0 0.00833333d0

|

1

|

I

1

rainBasin.txt

rain_hyeto.txt
rain_dist.txt

rain_cum.txt

L1 : [in] rainfall file (RRI format) [mm/h]
L2 : [in] catchment mask file (e.g. dem file)
L3 : [in] rainfall x11 corner

L4 : [in] rainfall yll corner

L5 : [in]

L6 : [out
L7 : [out
L8 : [out

ainfall cellsize (x, y)

—

hyetograph [mm/h]

total rainfall distribution map [mm]

—_—

cumulative rainfall [mm]

Executing “rainBasin.exe” creates three output files identified in L6, L7 and L8 to show

hyetograph, total rainfall distribution map and cumulative rainfall, respectively.

Note: To calculate average rainfall over a sub-catchment, one can replace the file indicated in
L2. First, one can use GIS to delineate the sub-catchment and convert the mask into ASCII
GIS format. For areas having pixel values greater than -10 will be considered as a

sub-catchment area.
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5. Conditions Setting for RRI Simulation

5.1 Folder Configuration

The following shows the folder configuration and roles of each folder in /RRI/Model

[/RRI/Model]

| hs
infile

, out

| source
10 i 1 4 l.exe
[ calcHydro.exe
i8] calcHydro.txt
[ calcPeak.exe
] calcPeak.bxt
8| hs.plt
| hydrograph.plt
[&] make_1_4_1.bat
|| Makefile_1_4 1
[&] makePostProcess.bat
B’ RRI_Input.txt

[Important Files]

-Folders-
infile : Stores following sets of input data for each project
- Adjusted topography data (adem)
» Flow accumulation data (acc)
» Adjusted flow direction data (adir)
- Rainfall data
(optional)
* Land use data
* Initial and boundary conditions
out : Stores simulation results for each output time step
* hr_ : River water depth [m]
* hs_ : Slope water depth [m]
» gr_ : River discharge [m?/s]
» qu_ : Slope discharge for x direction [m?3/s]
» qv_ : Slope discharge for y direction [m3/s]
» gampt_ff : Green-Ampt cumulative water depth [m]
- storage.dat : water balance checking file
source : Fortran source programs of RRI Model
hs: Stores figures of inundation depths (hs) by gnuplot

 make_1 4 1.bat: Compiling RRI model source (use Makefile_1 4 1 for UNIX/LINUX)

*0_rri_1 4 1.exe: RRI model execution file

* RRI_Input.txt : RRI model control file

[Other Programs and Files]
- makePostProcess.bat : Compiling calcHydro.exe and calcPeak.exe

- calcHydro.exe : hydrograph calculation program (post processing)

- calcPeak.exe : peak inundation depth calculation program (post processing)

* hs.plt : gnuplot script to create inundation depths figures (prepared by /etc/prepHsPIt)
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5.2 RRI Model Control File (RRI_Input.txt)

:- L1 | RRI_Input_Format Verl 4_1 1
I 1,9 RRI_Input.txt 1
1 |
1 L3 | ./infile/solo30s/rain_solo_30s_gauge.dat 1
: L4 | ./infile/solo30s/adem2_solo_30s.txt :
1 L5 | ./infile/solo30s/acc_solo_30s.txt 1
I L6 | ./infile/solo30s/adir_solo_30s.txt :
| L7 I
1L8 |0 # utm(1) or latlon(0) !
: L9 |1 # 4-direction (0), 8-direction(1) :
1 L10| 360 # lasth [hour] I
' L11| 600 # dt [secl !
 L12] 60 # dt_riv [sec] I
I L13| 96 # outnum [-] :
: L14( 110.2d0 # xllcorner_rain I
1 L15( -8.3d0 # yllcorner_rain !
: Li16| 0.00833333d0 0.00833333d0  # cellsize_rain :
1 L17 ‘l

Note that #comment is allowed only for lines with numbers like .8 to L16, but it is not

allowed for lines with characters like L3 to L6.

L1 : Version of the control file format.
This version has to be compatible with the RRI program version. When RRI Model version is
updated, user may be requested to modify this control file to be suitable for the updated

version.

L3 — L6 : Paths of the input files (rainfall, dem, acc, dir)
Note that adjusted direction file having zero at the outlet must be read in the flow direction

column. This adjustment (for dem and dir) can be implemented through the process of
demAdjust2.

L8 : Topographic and rainfall data coordinate system (UTM (1) or Lat Lon(0))

L9 : Simulating with 4- (0) or 8-direction (1) by the two dimensional model [default : 1]

L10 : Simulation period [hour]

L11 : Simulation time step [secl, [default : 600 sec]

L12 : Simulation time step for river [sec], [default : 60 sec]

The above time steps are just initial setting. The adaptive Runge-Kutta algorithm used for

RRI simulation may shorten the time steps if necessary.
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L13 : Number of output files
Simulation period specified above is equally divided for simulation output.
L14 — L16 : South west coordinate and resolution of rainfall data

Number of col and row are written in the rainfall data.

: 1.18] 0.03d0 # ns_river RRI Input.txt :
| L19] 1 # num_of landuse I
p L20| 1 # diffusion(1) or kinematic(0) !
1 1.21| 0.4d0 # ns_slope :
| 1.22| 0.0d0 # soildepth I
1 L23| 0.475d0 # gammaa :
: L24 I
1 L25( 0.d0 # ksv :
:L26 0.3163d0 # faif I
| L27 l
I 128| 0.0d0 #ka !
1 1.29| 0.0d0 # gammam I
1 L30| 0.0d0 # beta !
: L31 ‘|

L.18 : Manning’s roughness in river channel

L19 : Number of landuse

Parameter sets specified below should correspond to the number of landuse specified here.
For example, if there are three landuse types in a catchment, write three different parameter
sets. Prepare also the landuse map which has numbers from one to three, so that the
parameter sets described below will be assigned to each landuse grid cell. First column

parameters are assigned to landuse type “1” in the landuse map.

L.20 : diffusion (1) or kinematic (0) [default : 1]
The default mode of RRI model uses diffusion wave equations. However, by setting zero here,

RRI model can use kinematic wave approximation.

L21 : Manning’s roughness on slope cells
122 : Soil depths [m]
123 : Effective porosity [-]

L25, 126 : Green-Ampt infiltration model parameters

Set ksv = 0 for inactivating Green-Ampt infiltration model.
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“ksv” : vertical saturated hydraulic conductivity [m/s], "faif” is the suction at the wetting front
defined by St

Note: In the previous versions of RRI Model, “delta” and “infilt_limit” parameters were used.
The parameter “delta” is now replaced by “gamma” to represent soil porosity minus initial
water volume content (¢ —8,). The “infilt_limit” parameter is computed within the RRI
program by multiplying “soildepth” and “gamma” to estimate the maximum cumulative
infiltration depths in meter. Once the cumulative infiltration depths reaches to this maximum

depths, no more infiltration happens at the grid-cells.

L28 — LL30 : lateral subsurface and surface model parameters

L.28 and L30 are options to consider unsaturated and saturated subsurface flow and surface
flow in lateral direction. “ksv” is lateral saturated hydraulic conductivity (which is typically
two or three orders high compared with the vertical hydraulic conductivity set for
Green-Ampt model. To start with, set zero for “dm” to inactivate the option to consider
unsaturated subsurface flow. Setting zero makes no saturated subsurface flow consideration.

See 8.7 for the details of the parameter settings.

Note: In the previous version of RRI Model, a parameter “da” was used to represent maximum
water depth in saturated subsurface flow. Now this is calculated as “soil depth” times

“gamma” within the program.

L32-L36
Set “kgv = 0.d0” to avoid groundwater computation, whose algorithm is under development

and not completed at RRI verl.4.15. LL33-L.36 become inactive with kgv = 0.d0.

L38 — 44 : River channel geometry setting by equations
width =c, A™
. S,
depth =c, 4™

The above equations are used as default settings for river channel widths and depths.

Note that A4 in the equations is the upstream catchment area [km?] for each river grid-cell.

L46 — L49 : River channel geometry setting by files (optional)
If one would like to set width, depth and embankment height from files instead of the above
equations, set 1 in .46 and prepare the files in ESRI/ASCII format.
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: L.38] 20 # riv_thresh :
1 1.39| 5.0d0 # width_param_c RRI Input.txt |
: L.40| 0.35d0 # width_param_s :
1 41| 0.95d0 # depth_param_c |
: L4211 0.20d0 # depth_param_s :
1 L43| 0.dO # height_param I
I L44( 20 # height_limit_param 1
! 145 ;
I L46( 0 |
| 147/ /infile/solo/width_solo.txt !
I L48| ./infile/solo/depth_solo.txt |
:L49 Jinfile/solo/height_solo.txt :
1 L50 I
I a

L51 — LL55 : Initial water depth on slope, river, groundwater and GA Model cumulative by files
(optional)

If one would like to set initial water depths on slope and river for each grid cell, set 1 in L51
and prepare the initial condition distribution files specified in L52, LL53, L54 and L55. Note
that the format of the files is the same as RRI model output.

P e o e e e e o e e e e e e e e e e e e e e e e e e e e e e e e e

L511 0000

L52| ./infile/solo30s/hs_init_dummy.out
L53]| ./infile/solo30s/hr_init_dummy.out
L54| ./infile/solo30s/hg_init_dummy.out

RRI_Input.txt

|
|
|
|
|
|
L55]| ./infile/solo30s/gampt_ff_init_dummy.out 1
L56 :
L571 00 1
L58| ./infile/hs_wlev_bound_dummy.txt :
L59]| ./infile/hr_wlev_bound_dummy.txt I
L60 1
L61| 00 !
L62| ./infile/hs_disc_bound_dummy.txt 1
L63| /infile/hr_disc_bound_dummy.txt :
L64 I

L57 — L59 : Water depths boundary conditions (optional)

L57 : Slope water depths boundary conditions, .58 : River water depths boundary conditions
See Section 8 for the format of the boundary condition files. Use flag 1 for one-dimensional
data format (i.e. time series data at specific boundary condition locations). Use flag 2 in case
the boundary condition files are prepared in two-dimensional data format, whose number of

grid-cells must be the same as the topographic data including dem, dir, and acc. In both cases,
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time stamps in the boundary condition can vary within the file.

L61 — L63 : Water discharge boundary conditions (optional)
(Same as L57 — L59)

1 165 | 0 |
1 L66 | ./infile/solo/landuse_solo.txt RRI_Input.txt 1
| L67 |
1 L6810 1
: L69 | ./infile/dament_ALL.txt :
 L70 1
1L71]0 !
| L72 | /infile/div_dummy.txt !
1 L73 1
' L74| 0 !
1 L75 | ./infile/potential ET.txt 1
: L76 | 110.2d0 # xllcorner_evp :
y L7711 -8.3d0 # yllcorner_evp |
I LL78 | 0.00833333d0 0.00833333d0  # cellsize_rain !
! 179 :
1 .80 O 1
: L81 | ./infile/solo30s/section.txt :
1 L82 1
:L83 0 :
1 L84 | ./infile/solo30s/sec_map.txt |
I L85 | ./infile/solo30s/section/sec_ :
| 186 !
B o e o o o o e e e e e e e e e e e e e e e e e e o - 4

L65 — L66 : Landuse setting (optional)
If one would like to use multiple parameter sets for different grid-cells, set 1 in L.65 and read

landuse file specified in L66.
L68 — 69 : Dam condition setting (optional)
RRI model simulates the effect of dam reservoir operations based on simple rule. Refer to the

source code “RRI_Dam.f90” for details. (See also 8.11)

L71 — L72 : River diversion setting (optional)

River channel diversion setting (See also 8.10)

L74 — L78 : Evapotranspiration setting (optional)
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Prepare ET file and specify the path on L74. The format of ET file is the same as rainfall. The
resolution and xIl and yll corners can be different from the rainfall file as far as it covers all

the simulation domain.

L80 — L81 : River length setting (optional) : newly added option to set arbitrary the length of

river channel for each river grid cell (under preparation for more detail on this option).

L83 — L85 : River cross section settings (optional) : newly added option to set arbitrary cross

section information for each river grid cell (under preparation for more detail on this option).

 L87(1101000001
:L88 Jout/hs_
 L89 | Jout/hr_
1 190 | .Jout/hg_
:L91 Jout/qr_
1 L92 | .Jout/qu_
:L93 Jout/qv_
1 L94 | Jout/gu_
|
|
|
|
|
|
|
|
|

RRI_Input.txt

L95 | .Jout/gv_
L96 | .Jout/gampt_ff
L97 | .Jout/storage.dat

199 |0
L100| ./tecout.dat

L87 — L97 : Output file settings
Change the settings of LL77 to “1” to output different sets of simulation results listed in the
same order between L78 and 1.84

L99 — LL100 : Output simulation results in Tecplot format (Optional)

Set 1 in L86 if one wants to get the input input file for Tecplot to visualize simulation results.
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6. Running RRI Model

(@D Compiling RRI Model using make.bat
@ Prepare “RRI_Input.txt” in “/RRI/Model/” folder (One can copy the sample of input file
from /RRI/Model/infile/).

@ Execute “0_rri.exe”’, which reads the RRI_Input.txt stored in the same folder.

hs *For the folder configuration and roles of each folder
infle ] of the RRI model, see Section 5

out Run 0_rri.exe

source

B 0_rri.exe
" calcHydro.exe
calcHydro.txt
" | calcPeak.exe
B calcPeak.txt
& hs.plt
@5 make.bat
Makefile

Calculation conditions are

%| makePostProcess.bat

displayed before calculation begins
8] RRI_Input.txt

o< C:¥RAT¥Model¥rriexe Calculation status is

displayed

>+ C:¥AR¥ModcHrri.cxec

0.000000C WN000E+000 o :
_00000000000000O0E+000 loe =
0,000
2160
NOOO000NEHIDD oo @
010000 eellzize_rzird max bs: [ 00000 0 loc :

Aum_of _lar :

In = 0.000 0,000

da : 0.000

@t 0. 0,000
0.000




7. Visualize Output Data

This section explains how to visualize RRI Model output.

7.1 Format of the Output Files

Each output file contains water depths on slope (hs_) and on river (hr_) and river discharges
(gr_) on river at a particular time step. The units of the output are [m] for water depths and

[m3/s] for discharge.

el Number of grids in X direction (col)

VD BEQ TRQ BRY Y-A0 BRQ

D@ Hl 90 « » 986 FLFT T 6 =

[3 1 2 N i I I I in 2 i 1 ol e I3 1 13 Iz IFe Zi—
1 W o Eoes T.00TEE LTI )
i 0.0 0.0 0.00088 o.0000 o c.ooeee 0.00008 0,000 0.moes o.00008 1.00008 0
3 o.o000m 0.to000 0.00000 o.000M o . c.o0008 0.00008 000 0.00008 ).00008 0) 0
‘ 0.0080 0. to0es 0.00088 2. 00084 0.00008 0.00088 oo 0.00000 ». 00001 0,000} 0
5 0.0000 0.(0008 0.00000 0.00084 0.00008 0.00008 (23] 0.00000 1.00000 0.00008 0
& 0.0000 0,000 0.00004 2.00004 0.00008 0.0000¢ 008 000008 ).00084 00000 0
o~ y 00060 010068 0.00088 000881 0.00068 0.00088 CO. nop 0.00000 100001 0.000) 0
' .ooon 0. 0.00008 0.o00m c.o0008 0.00000 000 0.00000 ).00000 0.000) 0
g 1 (oooe 0.00080 2.0000 0.00008 0,00066 08 0
' i 0.00008 3.00080 0.00008 0.00088 0.00100 0.03000 0 0
O 1 weer 0.00000 0.00004 0.00000 0.00008 0.00108 0.00008 0 e 0
1 =] ? wooes 0.00088 0.0000 0,00080 000008 000108 0,00008 0 1 loc | 0
- i 00He 0.00008 2.0008) 0.00000 0,00008 0,00108 0.09000 0 ? 0
‘ woers 0.00008 200661 ©.00008 o.000te o.0010e o eoee o
o s .000M .cooe 0.00088 9.00004 0.01068 0.)0008 0.00008 0.00088 0.00160 0.09000 0.00008 3.00001 0.000) ]
] o.000m 0.0 0.00008 o.000m 0.01008 0.00000 o000 0.00000 0.00100 0.0000 0.00000 r.00008 o.00000 0
(o] i o.o00m o.co08s o.00088 aLo0ee o.oieee o.)00ee c.00088 o.0008e o.00iee o.03008 o.00008 1100008 o.0000e o
. ' 0.0008 0.00088 0.00088 000084 0.01008 0.)0008 0.00008 0.00086 0.00100 0.00000 0.00008 3.00081 0
] 0.0000 0.(0000 0.00000 0.00004 0.01000 0.)0008 0.00008 0.00000 0.00108 0.00008 0.00008 100000 0
' 0.0000 010048 0.00068 200681 0.01000 0.)0060 0.00000 0.00008 0100108 0. 0000 0.00606 ¥, 00004 o
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3 0.00088 0.(0068 0.00008 9.0000 0.01080 0.)0068 0.00008 0.00088 0.00108 009008 0.00008 3.00001 ]
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L oc_l! o0.000m 0.o000t oc_l’ oc_J c.oo008 0.o0000 0.00100 0.0000 0.00000 r.ooomn 0
=] 1 Biaia meTeT 0.00088 9.00000 Bl B 3 0.00008 0.00088 0.00108 009008 0.00008 3.00088 0
1 0.0000 0.(0008 0.00088 0.00084 0.01008 0.)0008 0.00008 0.00008 0.00100 0.00000 0.00000 100000 0
m » 0.0080 0.coves 0.00088 200084 0’0008 030008 0.00008 0. 00086 0.00108 0. 09000 0.00000 ¥, 00004 0
¢ 0.0060 0.0088 0.00008 0,006t 0.01068 000600 0.00008 0,000 0.00160 0.03068 0,00006 1.00001 ]
’-d ] o.o00m o.woem 0.00008 0.o00m 0.0t000 0.)0000 c.oo000 0.00000 0.00108 0.mo00 0.00008 ).oo000 0
o 3 0.00088 0.00008 0.00088 0.00801 0,010 0.)0008 0,000 0.00088 0,00108 0.09008 0,00008 1.00008 [
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3 0.0064 0. (0088 0.00008 00088} 0.01068 0.)0068 0.00068 0.00086 0.00108 000008 0.00008 3.00081 0
g_‘ * 1] 0.00008 0.0000 0.01080 000008 o000 0,000 0.00108 0. mees 0.00008 10000 0
o 1 " 0.00088 9.00604 0.01068 0.30008 0,00008 0.00006 0.0010¢ 0.03008 0.00008 1,00001 0
2 " 0.00008 2.0000) 0.01060 0.)0068 0.00008 0.00086 0.00108 0.09000 0,00008 3.00001 ]
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Q § " 0.00008 2.0000 0.00008 0.)0008 0.00008 0.00008 0.00008 0.00008 0.00008 1,00001 0
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7 ‘ 0.00088 0.00009 9.00088 0.01068 0.)0008 0.00008 0.00086 0.00108 000000 0.00008 1.00081 0
¢ t 0. (0088 0.06068 000084 0.01008 010660 0,00068 0.00086 0.00160 0.03000 0,00008 3.00001 ]
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The numbers of rows and columns are the same as those of the topographic data.

Note that for each type of model output, the number of the files is defined in RRI_Input.txt
(L13 : outnum). The simulation period is equally divided by “outnum” and the number

assigned to each output file represents the output time stamp.

7.2 Visualize Inundation Depth with GNUPLOT

GNUPLOT can be used to illustrate flood inundation depth distributions. In RRI/Model, the
GNUPLOT script named “hs.plt” is included. To change the settings, one can edit “hs.plt”
directly or create another “hs.plt” by using a Fortran program named “prepHsP1t.f90” saved
in “RRI/etc/prepHsPIt”.




(@D Edit “hs.plt” file to change the configurations.

reset

set terminal gif medium size{ 672, 408

set pm3d map

set palette defined

(0.0 "gray", 1.5 "blue", 3 "green")

hs_plt.txt
Erop
Nhe size of \
output GIF file,
D) XandY
direction.

AN

set xrange [0:]

Color pattern settings :l

Use the same X
and Y ratio as

set yrange [] reverse
set zrange [0:] reverse

#set xrange [180:200]
#set yrange [435:455] reverse

DEM’s col and
TOW.

/

set cbrange0.:3]

set zrange[0.0]

From RRI output (hs_*** out) to gif

set output|"./hs/hs_000001.gif" |
splot ['./out/hs_000001.out"

set output "./hs/hs_000002.gif"

matrix t "000001 / 000096"

splot "./Jout/hs_000002.out" matrix t "000002 / 000096"

set output "./hs/hs_000003.gif"

splot "./out/hs_000003.out" matrix t "000003 / 000096"

[ e e e e e e e I

@ Start GNUPLOT program by clicking “/RRI/etc/gnuplot/binary/wgnuplot.exe”
Then open and select “hs.plt” script file.

i gnuplot

File Plot Expressions Functions General Axes Chart Styles 3D Help

[ ReplgT[ Open [DSawedfChiir | Print |[ FriSc |[ Prev |[ Next |
GNUPLOT (4
Version 4.4 patchlevel 4 UP
last modified November 2011 GN LOT
System: MS-Hindows 32 hit
Copyright (0) 1986-1993, 1998, 2004, 2007-2011
Thomas Williams, Colin Kelley and [Elied
I t h htt // B J. = M1 » Package » » Model vl MO R
gnuelot home: RS . snup |
faq, bugs, etc: tuoe "help seek m'___'i"”“:”ﬁ . . Eeulle®
innediate hele:  tyee Thelp” e R - 7
plot window: hit 'h' e AR or
Terminal tvpe set to ‘wxt' "‘.E:;j:-,» B e
znuplot> _ W EoEr o bs.pix
a8y
d Ta-Tw2
AT Select “hs.plt”
27 4NBM): v |Defauit(*,pit) -
(el (w0 [D) *rven]
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& RRI/Model/hs Right click and preview

: DPANF) WEE) F
2. | @@ v  RSAKI3—  HEl SFAMTEETE  FLWIALY-
m 7RI “ Ghs_oo0001.gif i hs pases
i sayama 1 = he_000003.gif
Ji Documents 5 hs 000005 gif T7AOMF) v ERP) v BFA-LE) SHdaU) v BLO) -
58 hs_ -

L RAL 58 hs_000007.gif Sahs)
I, summary [§8 hs_000009.gif A hs ] P . : : - v - 3
4 share =| [ hs_oooo11.gif B hs] 600079 / 0OROSG
4 share-sayama |5 hs_000013. gif 5 bs _— - 1 2:
| sayama_desk (SAYA_ (5 hs_000015.gif & hs] M !

: - 25 2
| EBERNEKTIOST | mns c00017.git — | - * |

e =
" 5"?_/51 i | [Ehs_o00010.gif Eehs P e =
E BEERU S 58/ hs_000021.gif Eahs) 150 |- . £
(5 hs_000023.gif 5 hs Fo A
L ) 84 hs_000025.g1f Sihs) 200 -

A FFaAX bk (88 hs_000027.gif 54 hs | "
= eoFr 58 hs_000029.gif 8 hs| - B
B e &8 hs_000031.gif 5% hs | 0 L] 160 158 208 258 300 398
B Za-ves T ke nnnnan it =T

{ hs_000001.gf E356: 2012/11/12 8:35 H42: §

GIF A X—% A=d: 571 x 287 =151

7.3 Hydrographs at Specific Locations

A Fortran program named “calcHydro.exe” can be used to generate hydrographs by picking

up values from “out/qr_***.txt” at specified locations.

@D Edit “RRI/Model/calcHydro.txt” (see more details “RRI/etc/calcHydro/00_readme.txt”)
L1 : [In] location file (e.g. ./infile/solo30s/location_solo_30s.txt)
L2 : [In] RRI output file (e.g. ./Jout/qr )
L3 : [Out] hydrograph file (e.g. ./infile/solo30s/disc_)

____________________________________ 1
I N .

" Jinfile/solo30s/location_solo_30s.txt calcHydro.txt 1
] out/qr_ :
: J/infile/solo30s/disc_ I
———————————————————————————————————— o

I Cepu 68 167 . 1
: (list all target locations) location 508 solo.txk :

I o o o o o e e e e e e e e e e e e e e e e e mm m mw mw mw mm o oww o]

@ Run “calcHydro.exe”. (Execute “makePostProcess.bat” in advance to compile.)

® Check the created files specified in L3 of “calcHydro.txt”. (e.g. ./infile/solo30s/disc_)

@ From GNUPLOT screen, open and select “hydrograph.plt”, which is a GNUPLOT script
file to plot hydrographs. Any other plotting software, such as Excel, can be also used to
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draw hydrographs from created files (e.g. ./infile/solo30s/disc_Cepu.txt).
In the location file (e.g. ./infile/solo30s/location_solo_30s.txt), one can list all target points,
(y-direction) and “loc_j” (x-direction)

1
' |
1
:which you want to calculate hydrographs. Write the “name of location” and “loc_i” :
' |
1
1
1

1
:To identify the observation points in mesh coordinate (loc i, loc_j), one can use :
1
1

: “/RRI/etc/coordinate.xlsx” to calculate based on the coordinate in latitude(y) and longitude(x).

111,381 7,186 Ducerwd Doyt

(Displaying “acc” on top to make sure the selected point is on a river grid cell.)

@ Open one of the topographic data (i.e. dem, dir, or acc)

ncols 336
Nrows 204
acc_solo_30s.txt
xllcorner 110.2
yllcorner -8.3
cellsize 0.00833333333333
NODATA=va1ue -9999

-9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999
-9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999
-9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999
-9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999 -9999
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@ Read the header part (red box in the above figure) of the topographic data and copy the

same information in the Excel file (i.e. /RRI/etc/coordinate.xlsx).

g E-ﬂ
s RS AT B BB Fr  EELLI IO Acrobat 2@ =
B ¥ [vs v o Tl = - EyEmesss - SeEA- 3 -
Eﬁ;ﬁuﬁ- 7 Ay" o o BrTiUTEEE - e j-ﬁzd‘fr
e B I Us|®-| @A | & T m B el - R Ryl I
D TR—F o 1 i = 2540 il BE
Et - £ | 95338883 v
A B ® | D E F | & | H I =
|nco|5 336 [<—Condition x 99 339981<— Input i 73 M
2 |nrows 204 v 1665602 ] TE
o =l 102
4l =2 i —2791 <-Qutput X 110.8042
5 cellsize 0008333 i -1304 W 720417
f
T |xur 113
8 |vur —f.6
o
10

11 Memo : This excel shest is used to conver (x, v) = (i, 1) or (i, I to (x, v)
12 1. Set colurmn B (heols to cellsize) kased on dem file for the simulation.
13 2. Set (x, v) in E2 and E2 to calculate (1, j) in ES and EB

14 3 Set (i, )in 2 and I3 to calculate (%, v) in [5 and I6

15
M 4 W] Coordinate /0 ) ] [J4] il ] v
I¥F | |[ED@m 130% (<) 0 *)

@ Type x and y (or lon and lat) coordinate of the target point, then the calculated mesh
coordinate (loc_i, loc_j) appears in (E4, E5).

(“coordinate.xlsx” can be used also to convert from (loc_i, loc_j) to (lon, lat).

7.4 Visualize Peak Inundation Depths

Fortran program named “calcPeak.exe” can be used to compute the maximum flood depths

based on RRI Model output (“out/hs_*.out”). See 2.2.3 the procedure more in detail.

@ Edit “RRI/Model/calcPeak.txt” file after RRI model execution.
In “calcPeak.txt”, L1 sets the path of dem file, L2 sets the RRI model output file to
calculate the peak, and L3 sets the number of output files. L4 defines the output file of
calcPeak program. See details the readme file of “/etc/calcPeak”.

@ Execute “calcPeak.exe”. (Execute “makePostProcess.bat” if the executable file does not

exist.)

Check the created files specified in L4 of “calcPeak.txt”.

The obtained peak water data follows ESRI/ASCII format that can be visualized with

ArcGIS.

® ©
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7.5 Visualize Inundation Depths with Google Earth (Optional)

7.5.1 Preparing KML File

By using “RRI/etc/makeKML.f90”, a kml file (e.g. “runoff.kml”) can be prepared.
User needs to edit “RRI/etc/Kml_input.txt”.

3.75
Jinfile/solo/adem_30s_solo.txt
Jrunoff.kml

: Dem file name (for lat,lon)

: Output file name

: Start time (Year Month Day Hour Min (UTC ))
: Number of gif files( = "outnum" of RRI_Input.txt )
: Timestep (hourly) ( = "lasth / outnum" of RRI_Input.txt )

Kml_input.txt

“Time step” needs to be input as “hourly” data.
This “Time step” should be “lasth” / “outnum” input
in "RRI_Input.dat”.

<GroundOverlay>

When 1t is executed,
“runoff.kml” is output.

|
|
|
: <TimeSpan>
|
|
|

<begin>2007-12-24T00:00Z</begin>

<end>2007-12-24T03:45Z</end>

</TimeSpan>
<Icon>
<href>hs_kml/hs_000001.gif</href>
</Icon>
<LatLonBox>

<north> -6.60000</north>
<south> -8.30000</south>
<east> 113.00000</east>
<west> 110.20000</west>

</LatLonBox>
</GroundOverlay>

runoff.kml

2% The output of “runoff.kml” reads gif files created in the folder of “hs_kml”.
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7.5.2 Preparing GIF Files with GNUPLOT

The method of plotting “hs_kml.plt” using “gnuplot” is shown below.

(D Prepare a gnuplot file (e.g. “RRI/Model/hs_kml.plt”), which can be essentially the
same as hs.plt explained above. However, the gnuplot script file used here (.e.
hs_kml.plt) must have some additional statements in the blue box in the following
figure. The statements delete unnecessary axis and legends to be appropriately

overlay on Google Earth.

t
rese _ hs_kml.plt
modify
set terminal gif medium size|672, 408 L‘rop

add

set Imargin O

set bmargin 0

Designate size so that the aspect ratio of
size and ratio of number of meshes match.

set rmargin 0

set tmargin 0

set notics This part must be added
set nokey to the original hs.plt file.
unset colorbox

set pm3d map

set palette defined (0.0 "gray", 1.5 "blue", 3 "green")

set xrange [0:]
set yrange [‘] reverse

set zrange [0:] reverse

#set xrange [180:200]
#set yrange [435:455] reverse

set cbrangel0.:3] The folder name, “hs kml”

should be input here.

set zrange[0.0:]

modify

set output "fhs_kml/hs_000001.gif"

splot "./Jout/hs_000001.out" matrix t "000001 / 000096"
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@ Start “GNUPLOT” and run “RRI/Model/ hs_kml.plt”.

s [hut Styles 40 lob

prev | Next |

Choir [

LOT

4.4 peichlevel 2

ified Yed Sep 22 12:10:34 FOT 2010
{

gAUpIOL Nome: nItp:/fave. grup oL, INT0

faa. bugs. etce: type “help seekine-assist
lanediate help: type “help”
plot windows nit 'n'

Select hs_kml.plt

Terminal Lyve set Lo “wxl’
cnup ot >

® An image file is prepared in the “RRI/Model/hs_kml” folder. (Note that a new folder

hs_kml must be created in advance.)
7.5.3 Visualize GIF files with Google Earth

(D Start Google Earth and drag “‘/RRI/Model/runoff kml”.

fooman, sl 20 RS ey ses SR A T “;‘%f

Fie EM View Tods A Hep

¥ Search | | e 0

1 Search

Get Diroctions  Mistory

v Places
+ &S vy Places hs
Qpmror- hs_km|
infile
il out
I source

57 0_Ti_1_4_1exe
= calcHydro.exe
2} caleHydro.txt
=1 calcPeak.exe

€ runoftkm!

gl + +

¥ Layors  Earth Gallery »

% make_1_4 1.bat
] Makefile_1_4_1

= makeKml3.exe

¥ makekml3.fo0

B AR Doy
e
solo.pl

.

% makePostProcess.bat 20




- § S .
& Gdea o w o ace GEDEER A QT
¥ Search E ‘&'A[* Y V',‘E"' @4. @, B X | = B | B Sign in
‘ Search
ex: Museams in New York, NY

Get Directions  History

¥ Places
+ @& My Places

STV ALV
18 picasa Link
> Y16 My picasa Pictures
> CIE runoffkml
+ [V & Temporary Places
> ¥IB runoff.kml

E[] 4+ | ¥

¥ Layers Earth Gallery »
4 @2 primary Database 4
> B ¥ Borders and Labels
T8 places
> £l 2 photos
== Roads
3 3D Buildings
> B ocean .5 Image Lanc
- 71 8% weather Data SIO, NOAA, U.S. Na

> Flge Gallery
AN

\

- Tour Guide

{voor o slite oo B i e GEREEE A e 1. To reduce the number of
figures, move the left marker to
the right edge, and superimpose
it on the right marker.

¥ Soarch

Get Directions  Mistory
¥ Places

+ By ny Paces
[=1 L0
e

s
) picasa Link
T 7163 My Prasa Pictures
© runcfkml
+ ¥ &8 Tamponry Places
Y1 runcffiml

A
Gv

TN o Ear el =
« W 5 pimary Database <
¥ sorders and Labels
@ places
* Photos
B Roads
03 30 Buldings
B ocesr
T weather
# Gallery

2. Set the permeability with the
ol s permeability slider.

4
2 more

Tow Guide s
= —

%  On time slider: The right marker represents the present time, while the left
marker is used for the number of figures to overlay. Figures in the period between
two markers are displayed.




® Execute animation.

3. If user wants to change the speed
of animation, click option button.

1. Drag the right marker, and move
it to the start time.

[B/23/07 9:36 PM 3
12/23/07 436 PW (2

art date/time:

Erd date/time:

Set the animation

speed by this slider.

Display fime in

@ UTG (Coordnated Lniversal Time)

~ Time zone on my computer

) Sp=cific time zone AGDT Austialian Central Day

L -

b _Animation spead: slhwer
[ L

[V Loop animation

%% <note>. During the animation, two markers should be moved at the same time.
If user can’t move the left marker, stop the animation and fit the left marker to the
position of right marker and restart the animation.

Sewr . sl s ee B e aeGEREES A -

| Fie Eon view Todls ASo  Melp
1 v search 0 4ol [ aln e Sien in
Search

Select “kmz” from types of file,
designate the file name as
“runoff kmz”, and click the save

n Na

Got Directions  History

v Places

1o By vy places button
(=] L5
2 B
FT 9O & s ..
& Ficasa Link R R T e———— T P
VI & My Picosa Pictures A4 D 14 4
© nunoftiomt B2 WA
| + 7183 Temporary Plaes &os(C) - & : FEon
<13 nunoftimi o O=T T2 :
Al puosm @ o
t ~mryuRe pram—
Cepy ':!‘ e ol
] fp—
= Delete
I n Delete Contents *2ARNY
¥ Layers Eart )i 104ARM
1. W5 pimoypoa Renome L 1
M P Bordesane  Rovent Covppetar
@ Places Save to My Plnces ok 0
® Photos — e e — A
EmRoads | Save Place As.. 37 ANB(N): wnoftimz >
- Ly R —
WG 30 Buiding . Pest 0 Googie EBrth Commaity Forum 27 AAORRCT): [ma (vdoma) =
@ ocesn Emad... l
£ weatrer
A Srapshot “ -
s Gallery e e Select “Save Place as ) =it
@ GiobalAwa  SUTAZ . . » J2AT-ONESR € g ok
O vore s from the right click menu.
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calcTecplot.txt

2007 12 24 00 # start tlme : Year. Month DaV Hour
360 #lasth [hour] : calculation time (1.10)
96 # outnum [-] : output file number (1.13)
./Model/infile/solo30s/rain_solo_30s_gauge.dat : Rainfall file (1.3)
/Model/infile/solo30s/adem_30s_solo.txt :Dem file (1.4)

110.2d0 # xllcorner_rain grid data of Rainfall
-8.3d0 # yllcorner_rain (from1.14 to 1.16)

0.00833333d0 0.00833333d0  # cellsize_rain

1101110001 Output file from RRI
/Model/out/hs._ (from 1.87 to 1.96)
./Model/out/hr_

/Model/out/hg_ User needs to edit these lines in “calcTecplot.txt”.
/Model/out/qr_ All the lines except for the first line (start time)
/Model/out/qu_ can be copied from “RRI_Input.txt” to be
/Model/out/qv_ compatible with simulation setting.
./Model/out/gu_

/Model/out/gv_

JModel/out/gampt_ff_

Output file name for Tecplot

JealeTecplot_out.dat (use “dat” for the extention)

TITLE = "Internally created data set"

VARIABLES ="X" All data outside the red border are

yn header information, which 1s not
\ to be modified

"DEM (m)" necessary )

"Rainfall (mm/h)"

"Water depth hs (m)"
"Water depth hr (m)"

" " “VARTABLES =" ...” shows the variables to
Water (%epth hg (m) be displayed on Tecplot. Edit this if
"River discharge qr (m3/s)" necessary.

"Slope discharge qu (m3/s)"
"Slope discharge qv (m3/s)"
"Ground discharge gu (m3/s) "
"Ground discharge gv (m3/s)"

"g-ampt (m)" )

ZONE T="Contour T ="

STRANDID=1, SOLUTIONTIME=

1=336, J=204, K=1, ZONETYPE=0Ordered

DATAPACKING=POINT

DT=(SINGLE SINGLE SINGLE SINGLE SINGLE SINGLE SINGLE SINGLE SINGLE
SINGLE SINGLE SINGLE SINGLE)
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Use “RRI/etc/calcTecplot.f90” to prepare an input file for Tecplot (e.g. “calcTecplot_out.dat”).
Prior to running calcTecplot.exe, edit “RRI/etc/calcTecplot.txt”, which sets the condition for

generating the input file.

(D Start Tecplot, and load data file.
[File] > [Load Data file(s)] > [Tecplot Data Loader] > [calcTecplot_out.dat]

It takes several minutes to load the data file.

View Flot Inset Anmate Dota Frome Options Scripting Tools Help

New Layout | E Tt M DALY B 720000 O A @
Open Layout... Ctris0
Save Layout Curl+S we 001 | 22Jan 2014 | No Data Set
Save Layout as... Ctrie W
L e Tt
Write Data fle...
Print Preview...
Print.. Cerl+e
Paper Setup...
= st oot o R
Export... =]
Preferences d g}th:v'l Loader -
Loader
B oo E‘x““j?:b 4 e
1...0.test140120_new.l) eneld Texl Loader N = =
e koA -esvm
3 .0.test140120_newoy HOFSLaader ... . m e EREs R
4 . ¥solo_test140120 lay L infil 2014/01/0... 274N ...
5 ...ecplot¥solo_testlay b make-tecw 77, 2014/0Y/2.. TFAI ...
|, Model-tec 2014/01/1... 7N F...
+ old-file 2014/01/2.. 7AW F...
N
Choose “Tecplot Data video 2014/01/2.. 7AW F...
+ der” f d g EiCTemlot out. ot £ 2014/01/2,..  DAT J7-{)L 584,785 KB
Loader ormat, an [Emaketec_outpyplt  2014/01/2... gouplot 3... 334,189 KB
X Click OK.
N— P
3 Select the output file of | _
Snoo P “calcTecplot.f90”. UGB )y
Sasp to Cod — - EFa
[ e, ) 3 I 1 — — N
i | el I__[D_K__] l[—Jcme' . i -
et s cpn
G i v
[ Pot Appresimaions Load a Datarile into the active frame T
—

7-12



(S 201501

ew Fob [t Ammate Oats Frame Options Sorpteg Tools Help

Choose“3D Cartesian”,

and Click “OK”

T

L~

B8 WA Qb 2T LN F RuDLL4 H wP0000 O &nh H@
Inital Pl Type (2D Catesian 7] =)
Frame 001 | 22 Jan 2014 | Incamally sreated data st
[ Show First 2 D'ansl!m s ‘ @
XY Linz
Use These Se Bojr Line
Sketch )
Automatic g
[ Cancel [ Help lJ
el

(3D elevation data is
displayed on Tecplot.
N
[ owkes. |
=
1?"““ " 2 "
Pl Agguosinaions. Click £ Salkct, Dr) to Selsct Group

@ Write data file (changing input data to binary data), and also save as layout file.
[File] > [Write Data file...]

[File] > [Save Layout] ..
By Making the binary data (*.plt), user can reduce the amount of time to reload

layout file. User needs longer time to reload without the binary file.

J ‘Z‘?f,,.",‘?,?',"'?,f’!’f‘"",“‘ frame Optirs  Scipting  Tooks  Melp
|2 & WS 4 &

New Layout

w7000 0 B &N

Open Layout... Crle0
Save Layout Crles ne 01
Save Layout as... CriewW
Load Oata Fik(s). .
e
- Jh L
Print Preview..
Print.... Qriep
Paper Setup...
Publish....
Export..
Preferences »
exit CirleQ
1..0_testl$0120_new.lay
2 .. ¥Tecplotwtec_out.lay
3 ..0_test140120_new.lay
4. ¥solo_test140120 lay
& ..acplotuscio_tect sy
Choose
Binary
“w L » '\
Select Binary” i

“Save Data File Using”
and Click “OK”.

T T
Redow | [ Fedm
o

¥ tuto Redom
. Cachm Graphucs.
[ Pht Agpraimations  S8ve the data in the

22 Jan 2014 | Internally created data set

Write Data File omm* L=

Deteils to Save
[ Tex
|| Gecrctics
[] Custor Labeks
|| Field Data
[Joata Sharing Linkage |I Possibla)
Face Neiphbor Irformation Generated by Tecpiot

Fie FomatVersion | Cunenl Tecplot 2003)  ~

S ye Data File Using: Zeve/Geometiy Format:
L @ Binary Point
™ A3CN @ Blck
Fre
aiiable|s):

_
v

3 DEM (m]
Ranfal [mmsh)
Watsr depth hz (m)
Water depth hr [
River discharge g (m3/]
Slepe diccharge qu [m3)
9 Slepe discharge gv [m3)

Layeut Azzocialion
Azzociale Layout with Newly Saved Data Fie

(RTFADIRRNT:

name, and Click “Save”.

| Tecplot -2 P Er
£8 : BiEY B8 H4X Bz
1, infile 2014/01/0... TrAL F...
) make-tecEZ 7ML 2014/01/2... 74N ...
L Model-tec 2014/01/1... 7L T...
J. old-file 2014/01/2... 27AI J...
1. video 2014/01/2... 74N F..
[ maketec_output.pit  2014/01/2... gnupiot J.. 334,189 KB
4 » »
Ir{ 1N .
7 IR [Binary Data Files (Xpl) -
[FJuRL
Edit your binary file

7-13



[ o s s
J ‘View. PIot. - Ineart - Anirmace -~ Data - Frame - Options - Scriptng - Teols. el -
New Layout IS % E M v K EA 70000 O &N B &
b e e T
o - - -%s - °"1 1 22 Jan 2014 | Iinternally created dataset
Save CrieW
Load Oata File(e)... |
Write Data Fie... 4
Print Preview... e
Print.... Cuiep _ _
Sape e RESIBIL ), Tocple .00 o \
Publsh...
Bxort.. k2] [=¥5 155 =< BAZ =
Prefeceices ¥ L infile 2014/01/06 16:26 T7 Il J...
o S Jimake-tecEI 74/ 2014/01/2114:10 T7 ()L J...
e 1 Modei-tec 2014/01/1716:35  I7 AL J...
3...0_test140120_newlay Ju old-file 2014/01/21 14:10 D71 J...
TRy Ji video 2014/01/21 14:12  TZ AL J...
{Et=c_outlay 2014/01/22 13:48 LAY D7 1)L 20 g -
‘ Edit your layout file
name, and Click “Save”
<[ I ]
T ILBIN: o _outlay - H’Q =
TrANOHEET) [ Linked Data (*Jay) BRI
e
koL [FJuRL: | [ savelLIRL
g | R *
7] Uss Relative Data Fils Path
et |V Usa Ralative Data Filz Pathe
] Cachm Gaaghcs:
T PutApoosmaions Savé the current Layout File

(D Edit the ratio of XYZ and hide the axes.
[Plot] > [Axis ...] Select “XY Dependent” in Dependency on “Z” tab and input Size
Factors in Z (following example shows the Size Factors Z is set to 0.1). Uncheck “Show
X(Y.orZ)-axis” on X, Y and Z tab to hide the axis.

[ VN 720000 M =A @&
e Uncheck “show Z-axis” checkboxes
on X, Y and Z axis.
& Zene Style...
‘ Streamtioces... I
{ Skees...
[‘ 80=Surfaces. .. |
2] Lightwg J Centour/Multi-Coloring.. [ T — RS
[Vl fmbwey | Vector » I Show Z-Avis | X Y@_I
Bt e X o
= e ooy . Rarée [ Grid | Ticks | Lebel | Tile [ Lins | Arca
" ' Nex 3 I .
T Preserve Lereth when Chancine Rarce [ Use Loc Scale
Mw; [ | Reverse Asiz Direction
Advanoet Control.... 2 “
Label Ponts and Celss.. Dependency oY Ralia Sie Factars After SeleCtmg ‘XY
Sy uming.. —— i B Dependent”, set “Size
- £ ot R
el - Factor” of Z as around 0.1.
@ %VZ Deperdet ! z 04
[T S
oy
==
[ Redow ] Rlodran
” Frame
7 Ao Redion
(¥ Cache Graghes ] ) "0
[ Pit Appsonmstions £t 3xis range, tickmanks, titl, posibon, dependency, etc.
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@ Fit the data display range to the target range.
[View] > [Data fit]

@ Edit point of sight angle.
[View] > [Rotate...]

o o =-
e Pt ot Armcke: Oota 1 Rotztion Mode |
D@ E  RedrawFrame iR b I
{30 Canetiar Redraw A1 anso [ Q) WYZAna <& Haais [T
Zone Sufacy Zeom ¢ . 5
s o E O Spheical ] Yawis [B
[ Mash o "
Fltortod P Everything Ctriee ) RoleBal  <Z] Zagis [
= Oua £t
7 Scatter Center Rotztion Step Size |deg) & -
7] shade Transiote/Mogndy...
Plidoe st Ctrl-L Center of Rotaton
Efects. P
Wltghing | Rt = = = = ¥ 1028
e E ¥ 1685 &
(2w copy view .
Poste View CuleA z 755 %
Wockspoce Y Spherica AnJes
Psi 500 1
J Theta -90.00 I
1 Aphs 000 1
Set as follows: Pl s
Psi 5.00 (e o)
Theta -90.00
I Clazs l-i H=p
Alpha  0.00 -
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@ Delete unnecessary frame
[Frame] > [Edit Active Frame...]

" k24
tae Uncheck “show Border
AL = - checkbox.

Zoen e Fit AN Frames to Paper Frame Dimanciche [Face: Ruler Unitz)
S Fn Sl See endPoston
Load Frame Style. Left Side 1.000C00 Width 9.0
Tie Frames... Tep Sice 0.220000
30 Mulv-Fromes.,
¥ e o E|-5h- 9:4 K 01
= Thiskness (%]
- /\./ . ol —nk - —_—
D \ [7] Shew Heardes Cobr O] Red
[7] ShowBeckgiound  Cakar
Frame Nzme Fiama 001
—— =
Close H
L L'-'-'L' l;llpj
Sasp 10 Pagme
Sasp 10 Gid
Guh i,
Frome
V] At Rediam
¥ Cache Guphics
1| Pt Apgraamation: Edit the octive frome's size, positon, border, header, end cobr

® Edit translucency of shade
Click “Zone Style” and edit the value of “Surface Translucency” on “Effects Tab” to change
the translucency of shade (e.g. 10%).

D SIS R WAL ST D08 RIS AL T

Mesh | Contour | Vector | Scatte | Shade |

@ e Hoﬁ]g.w:vadfwa.

it
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(D Select variables to draw contour. User can select variables up to eight variables. The

legends of variables are automatically set. The method to edit them is described in ®.

13R1. o @
= - - P - - e = B e
Filc Edit View Piot lnsert Animate Dota Frame Options  Sapting  Tools  Help
DEH 8 XA Qe #L 04N F WM 2L H 470000

12

|20 Canteman ”
e Silion Legend ID and
Larers: .
D o selected variables
Vel L ‘
_Scaller
Tshade
Ed )
Eflecis. 23,
By & wmlcgu—[m]u-Im!IW
¥ Trarahrency o
Zmame [ Recat Lovala— | [ Hew Lok [ Add Lovele |
Levels Level To Add
30 ]
108 << Add Levsl
408 o
5. 08
;s :2 Gontour Virisble L] - -
HEH - X Follow1ng variables are selected as an
23
3 24
28

example.

1. DEM
Rainfall(mm/h)
Water depth hs (m)
Water depth hr (m)
River discharge qr (m3/s)

Slope discharge qu (m3/s)

N oo W

Slope discharge qv (m3/s)

Click to Select, Drag to Select Group

@ Select variable to display. User can select variable from variables identified in (. Click
“Zone Style” and edit “Flood By’ on “Contour” tab to edit target variable and its
legend. "Water depth hs (m)” is selected in the following figure as an example.
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@ Edit legend.

User can edit color legend of contour as follows;

= 2] % |
- P - -
File Edit View Plot Insert Animate Dato Frame Options Scripting Tools Help

l
DeH B M4 Qb @0 L5%E Mauwddod % m70000 O &h\ B
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Zone Sulaces p
Laers Contour & Multi-Coloring Details [
(Mo = 5
[¥] Coniow Iq\ 1 2[3]4 5 6 7 8 [Waterdepthho(m) - 3
: s - :
[ vector N[ s gl Colorng | Eande | Lies | Lasoks | Losznd = o) ;
[ Scaiter | I— e Enter Contour Level Rangs
[7] Shad= | Resstlevels. || HNer Levels. |
[ Edge D Levels v Toadd () M, Mak, and Nurer of Lovels |
Eects B - P Uiy Mok rviDeta)
%:f;‘ﬁe,. 3: 04 [ <<nddlevel | ) Exporeniid Disitson +
5 i ok [ ——
P N ey : :
g }g Min: -0l I Mok Level ¢ 1
012 Mox . 000A8 b b et Lo [ i | !
12122 a1 1
‘ Reset Hanp=
+
Nacel | [ hep |
- 1
Remove Selected Levels ]
Set “Contour level Range” +
+
+
}
At
+
| Srap to Paper
" Srap to Gnd t
Obeci Dotals.. |
Redar || Rediew
Al | Freme
/] Ato Fediar
[¥| Cache Graphics 1 2 g i & 7 B 10
7] Plot Appiokmations

@ User also can edit “cut off” to display upper and lower color limits. Color up to 0.5m is cut
in the following figure as an example.
Contour & Multi-Coloring Défa_ -]

1 2(3]4 5 6 7 8 [Waterdethhs(m) ]
Levels |1 Coloring ¢ Bands | Lines | Labels | Legend |

e o o= -

Use Color Map Group }73 (Modem) v ‘Q
Color Distribution Method
@ Banded
) Continuous
Contour Values at Color Map Endponts:
Mir: [-0.1 ]
Max: [0.0089 Resst

[TJUze Approximate Continuous Flooding

Color Gutoff - .
[¥] Cutoff Golor Below Lu‘s 1
[l Cutoff Color Above 155445 | [

Color Map Adjustments
Reverse Cycles 1
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® User can check the time series of the contour figure.

[Animate] > [Time.. ]

)

52 Tecplot Focus 20137

Fle Edit View FPlot [nsa te |Data Frame Options Scripting Tools  Help
DeH & N4 & 0. DALl w0000 O

Zone Suface Tso-Surfaces... e
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Leyeis. — Mappings... Setfirgs | Animate

T Mesh Slices... —_—

Ve L) 1 e Stert T 3840 Min 80440

1 Vecin o End Tire 3046484376 Max 3045434

Bl Scater el Time Step Shio T Narbsr of Time Stepe 95
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Edos & 4 Key Frame Animation... Destinaticn reen -

Effects: g Opeicbon | Forwand -
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® Export animation file
User can export animation file.
[Animate] > [Time...]
Select “To File” in “Destination” and “AVI” in “File Format” on “Animates” tab in “Time

Details”. If user needs to edit animation speed, click “Generate Animation File” and edit

“Animation Speed” if necessary.

I Export ‘ I =

Animate Export Format AVI ~ | [V] Color
Start Time 39440 Min: 39440 '
End Tie 39454 84375 Max 3045658 Region !
Time Step Skip '71_ —— _Nimger_of_ Time Steps: 96 @ Use Width of Image on Screen
Destination iTo File v j ©) EnterWidth 300
File Format AV v Exported Image Dimensions: 778 x 632
[ ====== | Antialiasi
|[Genua!e Animati ionﬁelj \ B Anckieng .
--------- Supersample Factor (2-16) |3
L Animation Speed lfames/seck_10_ _ _1
I AY| Compression [Colot Preserving ']
| ok ) [coea ) [veo ] |
- = — v

(D Display timestamp information on animation
If user needs to display timestamp information on the contour figure, add textbox and
input as follows;

Time = &(SolutionTime%ddd dd-mmm-yyyy at hh:mm)

@ Display time series graph on plane view.
Select [Tools] > [Time Series Plot] > [Probe To Create Time Series Plot] and identify the
position by left click with the pointer “+” to display the time-series. Note that the variable
selected as “Flood By” will be shown on the time series graph. Hence user needs to change

the setting of Zone Style and “Flood By” to display different time-series (e.g. qr).
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8. Application Example

This section presents the application of RRI Model to the lower Indus River basin. The target
area is below Tarbela dam, Kabul and Panjdnad points as indicated below. The simulation
domain is about 340,000 km2 and the river length is about 1,400 km. In this example, the
river discharge boundary conditions are prepared based on observed discharge records during
2010 floods to force the model with rainfall records.

G 1ar

~ Panjnad -

“Detni &
New
Ol

A polygon covering the simulation target (the red mask in the above figure) was prepared first.
The flow direction data in HydroSHEDS (30sec) was used to identify the entire Indus River
basin. Then the upstream areas above Tarbela, Kabul and Panjnad were removed from the

entire Indus River basin.

The background image of the above figure can be obtained from the following site

(http://goto.arcgisonline.com/maps/World Imagery) and used in ArcGIS.

8.1 On Input Topography

By using the catchment polygon, dem, acc and dir datasets were clipped for the catchment
area. The function embedded in ArcGIS ([Spatial Analyst Tools] = [Conditional]l - [Conl) was
used to mask the target area out of the regional datasets of HydroSHEDS (30 second
resolution). Then “demAdjust2” program was used to adjust dem and dir to create adem and
adir.




8.2 On Input Rainfall

Ground gauged rainfall records provided by Pakistan Meteorological Department (PMD) were
used for the simulation. The green dots in the left figure below show their spatial distribution.
The below right figure is the formatted ground gauged rainfall data with the latitude and
longitude information. Total 93 data was used to create spatially distributed rainfall data.

S ————
ES - o0 ' PMD_Rainds [E3E—F] - Mirosoft Excal w
A | BA A-SLATH BE  F-5 £F B AL TbL  Acobat 2@o @R
1 & [MsPmwy -ju - = = ®BE - fismmaast - J=8A- E- 9? ﬁ
e BB 7 U Ay H- @y, BIAwLEARE PR @ -
MR | e Al = T pEs - | @ LIOAL R
DT At 2| nORE = 2540 | wE
Al - S 93 &
1 ) B [ ¢ ) £ F G H 1 J K &
1 53
2 Lt 2020 2020 2024 3137 3202 3126 W61 8387 8147 3230
3 len 7351 7147 747 7106 7088 7306 7310 7308 7219 7226 |
4 0 0 0 0 15 0 6 9 3z 0 15
5 86100 ) 0 0 50 0 60 999 999 23 20 |
(] 172800 5 999 -999 3 46 52 10 29 a5 85
7 250200 18 -999 -999 1 7 0 5 3 0 0
g | 45600 0 0 0 0 0 0 0 0 0 0
(g | 32000 0 0 0 0 0 0 0 0 0 0
(10| 51840 0 0 0 0 0 0 0 0 0 0
11 604800 6 o o 0 0 0 -999 3 0 ]
12 691200 1" 27 4 1 6 1 68 19 0 15
13 777600 0 5 14 59 6 12 3 30 15 52
14 854000 /] o 2 999 /] a 120 156 4 17
(15| 960400 0 0 0 0 0 0 0 0 0 0
16| 1036600 0 4 7 0 0 0 0 0 0 0
T =
R '!1 Positions Hairgata fior, Tb?ba\}:m \28 5 — m'i [l ’ - L ’ [
PLE _________ Eo@mowo U @
'=‘ —.——Eb—u

Note that the first column of the excel sheet represents the time stamp of the rainfall data in
second. For example, at the row of 172800 sec, the daily rainfall [mm/d] between time 86400
and 172800 sec was stored. Then all the data was copied to a text editor and save it as ASCII.




The ASCII file is the input data of /etc/rainThiessen program that generates the spatially
distributed rainfall data. Note that the “gauge map_lower_indus.txt” is also created after
running /etc/rainThiessen program, so that one can check the spatial representation of each

rain gauge (see the figure below after converting from the ASCII to Raster with ArcGIS).

gauge_map_lower_indus.txt ® 2
] o OOO
) ®
) )
)
° ® o ©
o %
o e
- [0}
o I 0 o
° ~
° "
e °
e @
2] ©
@ oo 2
g @ [5) [5)

Jindus/gauge_1d_2010.txt

24

Jindus/rain_lower_indus_gauge_ 2010.dat
Jindus/gauge_map_lower_indus.txt

rainThiessen.txt

ncols 80
nrows 120
x11 66.0
yll 23.0
cellsize 0.1 —» in degree

'-_____________
[ e e ]

The rainfall data must cover all the simulation domain. However, it is not necesssary to have
the same resolution or the same coverage area. For exmaple, 0.1 degree (approx. 10 km) may
be fine enough to distribute the ground gauged rainfall for this case. Thus above
rainThiessen.txt read by the rainThiessen program specifies the output resolution of 0.1

degree.
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ncols 960

nrows 1440

xllcorner 66

yllcorner 23

cellsize 0.00833333333333
NODATA value -9999

35.0

Topography
66.0 0.0083333 degree 74.0

resolution

23.0

66.0

Rainfall

66.0 0.1 degree

resolution

23.0

No need to be the same extent or the same resolutions,

as far as rainfall data covers entire simulation domain

I RRI_Input_Format_Verl 4_1
|
|

RRI_Input.txt

I /infile/lowerindus/rain/rain_lower_indus_gauge_2010.dat

: Jinfile/lowerindus/adem?2_lid1k.txt
1 ./infile/lowerindus/acc_lid1k.txt
: Jnfile/lowerindus/adir_lid1k.txt

|

10 # utm(1) or latlon(0)

L1 # 4-direction (0), 8-direction(1)
1 2568 # lasth

1 600 # dt

1 60 # dt_riv

: 104 # outnum

1166.0d0 # xllcorner_rain

1(23.0d0 # yllcorner_rain [¢

10.10.1 # cellsize_rain

|

L e e e e e e e e —————— ———

xllcorner_rain, yllcorner rain
cellsize_rain (x, y) are specified

in RRI_Input.txt

23.0

8.3 On Input Evapotranspiration

Current version of RRI Model does not have a function to estimate evapotranspiration from
climate variables. However, by giving evapotranspiration rate as one of the input files, the

model takes the equivalent amount of water from surface and subsurface storages.
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The format of the evapotranspiration input is the same as rainfall. Hense the grid cell size
and time step of evapotranspiration file can be arbitrary set. For example, to set the constant
rate of evapotranspiration, one can prepare the following input file (e.g. evp_4mm.txt), in

which the value of 0.166667 mm/h corresponds to 4 mm/d of evapotranspiration.

j011
1 0.166667 evp_4mm.txt
| 100000001 1
1 0.166667

e L L T

1
1
1
1
1
4

To read the evapotranspiration input file, set flag 1 on the LL71 and specify the input file name.
The coordinate of south west corner (xllcorner and yllcorner) as well as the cellsize (x and y

direction) must be also set in L73-L75.

r------------------------------------
1L71|1 :
: L72 | ./infile/lowerindus/evp_4mm.txt RRI Input.txt I
1 L73 ] 66.0d0 # xllcorner_evp
xllcorner_evp. yllcorner _evp
: L74 | 23.0d0 # yllcorner_evp <« ' ‘ '
1 L75 | 1000.d0 1000.d0  # cellsize_rain cellsize_rain (x, y) are specified
—_———m—mmemmmme============"in RRI_Input.txt

Note that if sufficient water exists on a slope grid cell, and if the grid cell store water in the
Green Ampt-Model, the model takes water from the cumulative water in GA model. If a user

wants to avoid the evapotranspiration from the GA model, use flag “2” instead of “1” on L71.

8.4 On River Channel Geometry Setting

RRI Model assumes the rectangle shape for all river cross sections. To determine river cross

sections (incl. width ¥, depth D and levee height H.), the following two options are available.

h, n. 1H,

D hr

A
A 4




A) Use empirical equations with parameters defined in RRI_Input.txt

B) Read the values from files and specify the files in RRI_Input.txt

' Las] 100 #riv_thresh A '
I .39 2.5d0 # width_param_c RRI_Input.txt :
: L40| 0.4d0 # width_param_s :
1 L41| 0.1d0 # depth_param_c > Option A I
: L42] 0.4d0 # depth_param_s :
1 L43| 0.dO # height_param "
: L44] 20 # height_limit_param ) |
1 L45 :
: L46( 1 & 0:OptionA / 1:Option B (Read from files) |
I L47| ./infile/lowerindus/width_lid1k.txt :
I L48| ./infile/ lowerindus /depth_lid1k.txt Option B I
: L49| ./infile/ lowerindus /height_lid1k.txt :
1 L50 "
S

A) For the first option. the parameters of the following empirical equations must be

appropriately set to represent target catchment condition (L38 — L44 of RRI_Input.txt).
width =c, A™
—_ Sd
depth =c, A
where A4 in the equations is the upstream catchment area [km?] for each river grid-cell.
The unit of width and depth are [m]. The parameter “riv_thresh” defines the threshold of flow

accumulation (i.e. number of upstream cells) to distinguish river grid cells or slope grid cells.

Recall that for RRI model, slope exists even on a river grid cell.

I L B v - e
g “’?‘i. Gnuplot (window id : 0) S [=[@] = ]
Flle Plot Expressions Functions General Axes e A7
Chart Styles 3D Help .
= - - 1 120 T T T T
[Replof [ Open [ Save [Cthr [ Print ][ Pris 25*x*0.4
grupl ot = | :
gruplot> 100 i —
grup | ot> .
grup | ot> 50 |- : S o
&nup| ot -
erup|ot> 1 ! -
= ; 2= ;
erue | ot> — 60 |------ eneesaras B o a e ran et ol Ses merran NPT SRS -
< L -
E -
//V/
40 .// S S i ¥ 3 X 5 ? : LR 3 o]
/
/
20 ?/ ....... TR R s =1
st xlabel "A [kn2]” i ; i i
s=t wlabel "W [n]” e
0 2000 4000 6000 8000 10000

gruplot> p 2.5 ¥ x ¥x (.4
&rupl oty _

<

-1366.66, 117.121
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CLE RN (-EYTIy  =mr

[Hezraaald?

T

File Plot Expressions Functions General Axes
Chart Styles 3D Help

[ Replot || Open | Save || ChDir || Print [ PriS

-

T
01*x*D4

znup lot>

zne [ot>

gnup ot >

gnip lot>

znp [ot>

anLp ot >

gnup ot >

gnLp ot

znp oty set zrid

gnie lot>

anip lot> set xrange [0:10000]
enuplot> set yrange [0:10]
zrie ot >

eniplot> set xlabel "A [km21”
anie lot> set wlabel "D [m]”
znip ot

znue lot>

gniplot> p 0.1 % 5 *x 0.4 (3 Alkm2|
gnLp ot v

I CH™| » 3664.91, -0.359066

B) For the second option. a user can prepare three files separately to represent width, depth,

and height distributions. All those files must have the same number of row, column and
resolution as the topography data (i.e. adem, acc and adir). The format of these data is ArcGIS
ASCII format (i.e. the same as the topography data).

Note that the width file (e.g. ./infile/lowerindus/width_lid1k.txt) is used to decide whether
each grid-cell has river or not (width > 0 is treated as a river grid cell). The values of depths

and heights must be appropriately defined on a cell where the width > 0.

To support for creating the width, depth and height files, a Fortran program called
/ete/makeRiver2/ can be used. The program reads “acc” file to calculate the upstream
catchment area A [km?] for each grid cell and a user can define different equations or fixed

values within the program to create the three river cross section files.
There are two kinds of embankment settings in RRI simulation.
A) Embankment along rivers
B) Embankment on slope grid cells
A) The first tvpe of embankment is illustrated in the figure of a river cross section. The effect
of embankment is considered during the interaction of water between river and slope. To

include the first type of embankment, the height value (height > 0) must be set on river grid

cells (width > 0). Because of the RRI Model basic structure, a river is set as a centerline of a
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slope grid, it is not possible to apply different embankment height for different side of the

river for this option.

B) The second type of embankment represents roads, railways or other structures that
prevent water to across. Since the embankment along the main Indus River is located a few
kilometers apart from the main channel (see above figure), this second type suits better. The
location information of the embankment was converted to raster data having the same
resolution with topographic data on ArcGIS. The above mentioned “herght’ file specified in
RRI_Input.txt can contain the height information (and therefore the embankment location

information) on slope grid cells.

Note that even if a user intends to set a continuous embankment apart from a main river, if a

tributary joins into the river and if the “Aeigh?’ value is set on a river grid cell where width >
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0, the embankment would be regarded as the embankment of Type A. As a result, the set

embankment will be discontinuous at the location.

To avoid the situation and elevate DEM even on the tributary (or river grid cells), one can use

the flag of “2” on L46.

8.6 On Land Class Setting

The effects of land cover (or soil type) can be reflected by assigning different model
parameters. In this example, GLCC-V2 (Global Land Cover Characterization) provided by
USGS was used. The original land cover data (left) is too detail to assign all different

parameters; therefore, similar land cover types were merged into two categories: Cropland

and Sparsely Vegetated, and also overlaid additional Floodplain polygon.

— Cropland
[ Sparsely Vegetated
- Floodplain

For re-classing the original land cover data, ArcGIS function [Spatial Analyst Tools] =
[Reclass] & [Reclass by ASCII File] was used. The following lookup table was prepared by a
text editor to define the re-class. Different lookup tables may be defined for different projects.
Note that the number of the raster data (in this case 1, 2 and 3) corresponds to the column of
parameter sets in RRI_Input.txt. Thus provide sequential numbers starting from 1 for

representing different land covers.




Finally the re-classed land cover was converted to the ArcGIS/ASCII format and saved it as
“lu_lid1k.txt”. Note that the file can be read by RRI Model by indicating the file link in
“RRI_Input.txt”.

I I
I I
: Lookup Table Legend of GLCC-V2 :
I' (Indus Example) !
! USGS Land Use/Land Cover System Legend (Modified !
I Level 2) I
! Value Description I
: 1:1 1 Urban and Built-Up Land :
1| 201 2 Dryland Cropland and Pasture I
: 3:1 3 Irrigated Cropland and Pasture :
I 4:1 4 Mixed Dryland/Irrigated Cropland |
I 5:1 5 Cropland/Grassland Mosaic I
Ll 6:1 6 Cropland/Woodland Mosaic !
| 7:1 7 Grassland I
! 8:2 8 Shrubland !
: 9:1 9 Mixed Shrubland/Grassland :
| 10:1 10 Savanna I
: 11:1 11 Deciduous Broadleaf Forest :
1201 12 Deciduous Needleleaf Forest I
| 13:1 13 Evergreen Broadleaf Forest |
: 14:1 <::| 14 Evergreen Needleleaf Forest :
| 15:1 15 Mixed Forest I
| 16:1 16 Water Bodies |
: 17:1 17 Herbaceous Wetland :
I 18:1 18 Wooded Wetland |
: 19:2 19 Barren or Sparsely Vegetated !
vl 2001 20 Herbaceous Tundra :
I 21:1 21 Wooded Tundra |
: 22:1 22 Mixed Tundra :
I 23:1 23 Bare Ground Tundra I
I 24:1 24 Snow or Ice !
: 99:1 929 Interrupted Areas :
| 100:1 100  Missing Data I
I I

8.7 On Parameter Setting

Model parameter values are defined in RRI_Input.txt. In this section, the general idea to
decide model parameters are described first, then a calibrated model parameter set for the

Indus River basin will be shown as an example.

For each land cover class, decide (A), (B) or (C) in the following figure depending on
infiltration and subsurface processes, so that the number of calibration parameters will be

limited.
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4,—————'"'————————————————————;

Surface / subsurface flow conditions

(A) Only overland flow

(no infiltration loss,

no subsurface flow)

;—"‘§~§§~§-§§~§-~§“‘--_;

(B) Vertical infiltration
+ Infiltration excess

overland flow

(C) Saturated subsurface

+ Saturation excess

overland flow

Example of parameter values (their recommended ranges)

Parameters Notation A) (B) (©
n (River) (m1/3s) ns_river 0.03d0 (0.015 ~ 0.04)
n (Land) (m/3s) ns_slope 0.3d0 (0.15~ 1.0)
Soil depth (m) soildepth 1.0 d0 (0.5 ~ 2.0)
Porosity (¢) (-) gammaa 0.471d0 (0.3 ~ 0.5)
ksv (m/s) ksv 0.d0 5.56d-7 0.d0
Sr faif inactive 0.273d0 inactive
ka (m/s) ka 0.d0 0.d0 0.1d0 (0.01-0.3)
Unsat. porosity (-) gammam Inactive 0.do
Yij beta inactive Inactive inactive

Note: 0.d0 is used in RRI_Input.txt to represent double precision of 0.0.

For case (A), where only overland flow without infiltration or subsurface flow process are

considered, set both ksv and ka equal to 0.

For case (B), where vertical infiltration + infiltration excess overland flow are considered, set

ka = 0, and the parameter “da” is equal to “soil depth” times “porosity”.

For case (c), where saturated subsurface + saturation excess overland flow are considered, set

ksv = 0, and the infiltration limit (defined as a parameter in the previous versions of the RRI

model) equals to “soil depth” times “porosity”.

Note that the parameter values in the above table are just one example values (approximate

ranges).
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Note that even though the values in inactive part do not affect the simulation result, a double

precision value like 0.0d0 must be filled in RRI_Input.txt (see the sample below).

* Set “kgv = 0.d0” to avoid groundwater computation, whose algorithm is under development
and not completed at RRI verl1.4.145.

** If both ka and ksv are set to be non-zero, RRI will stop with an error message.

The following figure shows an example of parameter settings

: L18| 0.03d0 # ns_river RRI_Input.txt :
I L.19] 3 # num_of landuse I
1L20] 111 # diffusion(1) or kinematic(0) I
: L21| 0.15d0 0.15d0 0.15d0 # ns_slope :
1 L22| 1.0d0 1.0d0 1.0d0 # soildepth |
: L23| 0.4d0 0.4d0 0.4d0 # gammaa :
| L24 ,
I L25| 5.556d-7 6.056d-7 0.d0 # ksv 1
: L26] 0.273d0 0.1101d0 0.d0 # faif :
1 L27 1
: L28| 0.1d0 0.1d0 0.1d0 # ka :
1 L29] 0.0d0 0.0d0 0.0d0 # gammam |
: L29] 8.0d0 8.0d0 8.0d0 # beta :
 L31 I
1 .32 0.d0 0.d0 0.d0 # kgv 1
: L33 L36 are inactive under kgv = 0.d0 :
e o e o o o e e e e e e e e e e e e e e e e e e e e e e e e e e e 4

Reference Table : Green-Ampt Infiltration Parameters for different soil texture

Soil texture class ksv (m/s) ¢ [gammaal Sr(m) [faif]
Sand 6.54E-05 0.437 0.0495
Loamy sand 1.66E-05 0.437 0.0613
Sandy loam 6.06E-06 0.453 0.1101
Loam 3.67E-06 0.463 0.0889
Silt loam 1.89E-06 0.501 0.1668
Sandy clay loam 8.33E-07 0.398 0.2185
Clay loam 5.56EK-07 0.464 0.2088
Silty clay loam 5.56E-07 0.471 0.273
Sandy clay 3.33E-07 0.43 0.239
Silty clay 2.78E-07 0.479 0.2922
Clay 1.67E-07 0.475 0.3163
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From Rawls, W.J. et al.., 1992. Infiltration and soil water movement. In: Handbook of hydrology. New York:

McGrow-Hill Inc., 5.1-5.51. (Units are conveted for RRI Model)

8.8 On Boundary Condition

The following river boundary conditions were set based on the observed discharges at the

three locations during the 2010 flood.

Tarbela
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5000 |

Kabul

Observed —=—

ok - - : -
July20  Augl Aug10 Aug20 Sepl Sep 10 Sept20

Time (Date)

The steps to set river discharge boundary conditions are described below.

D Find locations to provide the boundary conditions.

Viewing acc values on ArcGIS can help you to identify appropriate position with lat lon

information along a river channel. Use i (identify) icon to find out the coordinate.

Then use the “/etc/coordinate.xls” to convert from the lat lon coordinate to loc_i and loc_j. See

Section 7.3 on the conversion in detail.
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The number of boundary condition setting points

The loc_i and loc_j of all points to give
I / . .
I loc i 110 119 680 boundary conditions
: locj 803 719 602

10 3936.041733 3007.249151 917.4658428
121600 3936.041733 3007.249151 917.4658428
43200 3936.041733 3007.249151 917.4658428
64800 3879.408039 3044.061053 917.4658428
86400 4813.86399 3015.744206 917.4658428

108000 4700.596602
129600 4842.180837
151200 4672.279755

2944.952088
2899.645133
2922.29861

917.4658428
917.4658428
1093.030294

Time series of the boundary condition
data (units: [m3/s] for river discharge,
and [m] for water depth)

@ Settings in RRI_Input.txt
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After preparing the boundary conditon file (e.g. disc_lid1k_2010.txt) and move the file in the
appropriate folder (e.g ./infile/lowerindus/), edit the RRI_Input.txt file as follows.

L51[ 0000 RRI_Input.txt
L52| ./infile/lowerindus/hs_init_dummy.out

L53| ./infile/lowerindus/hr_init_lid1k.txt
L54| ./infile/lowerindus/hg_init_sample.out

L55| .Ainfile/lowerindus/gampt_ff init_dummy.out
L56
L57]1 00

L58| ./infile/wlev_bound_dummy.txt
L59| .Ainfile/hr_bound_dummy.txt

[-—————————=——————————

L60 Write the file name of river discharge boundary
L61| 0(1) .
L62| /infile/gs bound dummy.txt y :
L63| ./infile/lowerindus/bounds/bound_lid_2010.txt I
L64 ‘I

Another option is to use two-dimension format for setting boundary conditons. In that case,
prepare the following “setBound.txt” first as the input file to “/RRI/etc/setBound” program,
which creates the input boundary conditon file (e.g. ./disc_lid1k_2010.txt) on two dimensional

basis. The two-dimensional boundary condition files can be read with flag 2 on L61.

..I../Model/infile/lowerindus/adem_lid1k.txt
../../Model/infile/lowerindus/acc_lid1k.txt
..I../Model/infile/lowerindus/adir_lid1k.txt
Jinfile/lowerindus/disc_Constant.txt
..I../Model/infile/lowerindus/disc_lid1k_Constant.txt
3

119 719

110 803

680 602

setBound.txt

In the above example of “setBound.txt”, L1 to L3 are the paths to the topography files (dem,
acc and dir). L4 is the 1D discharge file (input) prepared above and the L5 is the output of the
setBound program. L6 indicates the number of points to give the boundary conditions,

followed by the positions in loc_i and loc_j.
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The created boundary condition files have the same format as the rainfall file. However,
unlike rainfall files, the number of columns and rows must be exactly the same as the

topography data, so that RRI Model knows where to give the boundary.

Note that discharge boundary conditions including along river and on slope must have the
information of the directions. In other words, they should be vector values rather than the
scalar values. To decide the direction of the discharge boundary conditions, RRI Model refers

to the flow direction in “dir” file.

Water level boundary conditions on slope and/or river can be also set by changing the value on
L57 to 1 and specitying the boundary condition file name. The file format is the same as the

river discharge boundary condion.

8.9 On Initial Condition

RRI Model can take initial conditions for water depths on slope and river as well as the
cumulative water depth in the Green-Ampt model. The format of the files is the same as the
output of those variables, so that one can use the output of the RRI as the input for the next

simulation.

This feature enables the continuous long-term simulation. In order to read the initial
conditions, L49 to LL52 in the RRI_Input.txt must be edited in a same manner as the example

of the boundary condition setting.

8.10 Diversion option (for advanced users)

RRI model can simulate the effect of diversion in a simple way. The portion of the diversion
from a main channel to a diversion channel must be pre-defined by a model user and

described in RRI_Div.f90 program. The followings are the basic steps to activate the option.

O Edit input river cross section files (i.e. width, depth, height) and flow direction files to add

necessary diversion channels (e.g green arrow for the below figure).

@ Check a origin cell (loc_i_org, loc_j_org) and a destination cell (loc_i_dest, loc_j_dest).
Both the origin and destination cells must be specified on river grid-cells. Typically these

two are adjacent, but not necessary (i.e. diverted water can jump into an apart cell).
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/ \
i=1 Q Diversion origin cell (loc_i= 1. loc_j = 2)
i=2 \ o /-\ Added diversion channel

(Diversion destination (loc_i = 2. loc_j = 3)

i=3 dir = 2. width > 0. depth = 0. height > 0
- 64
dir 32 128
1i=4
16 1
1=5
8 2
4

@ Prepare a file to specify the origin and destination cells based on the following format.

One can list up multiple lines if more than one diversion should be considered.

@ Edit “RRI_Div.f90” source code. The simplest way is to decide a ratio to divert from a
main channel to a diversion channel. Be sure to recompile the program once the souce

code is modified. The part of “RRI_Div.f90” program that users may edit is as follows.

dol=1, div_id_max |
k = div_org idx(1) RRI_Div.f90 !
kk = down_riv_idx(k) |
kk_div = div_dest_idx(1) :
if(leq.1) then 1
if( qr_idx(k) .gt. 0.d0 ) then :
I

|

I

I

I

|

I

qr_div_idx(k) = qr_idx(k) * 0.1
qr_idx(k) = qr_idx(k) - qr_div_idx(k)
endif




In this program, the variable “div_id_max” is defined automatically as the number of the
diversions (i.e. the number of lines in “div_sample.txt”). Users need to edit the above blue
lines to define the portion (or other rule) for each diversion. Add another set of lines for
another diversion started with if (l.eq.2) etc. For the above example, 10% of flow from the

main stream at (loc_i = 1, loc_j = 2) is diverted to the stream at (loc_i = 2, loc_j = 3).

® Activate this option by setting flag 1 on L70 and specify the diversion file name on L71 in
RRI_Input.txt.

8.11 Dam option (for advanced users)

RRI model can simulate the effect of dam reservoirs in a simple way. The dam model has two
parameters: outflow discharge and maximum storage volume. The model takes storage
volume as a state variable, which continues being updated based on simulated inflow and
outflow. The outflow is maintained at a certain discharge rate that is lower than the inflow
rate until the storage volume reaches the dam’s maximum storage level. After the storage
volume exceeds the maximum level, the model is designed to release the water at the same
rate as the inflow rate. The parameters must be determined based on dam operation records.

The followings are the basic steps to activate the dam model.

(D Prepare a dam parmmeter file by the following format.

= = = e e e e e e e e === - — - 1
12 1
1 Sirikit 135 166 3510000000 500 |

1

dam names, loc_i_dam, loc_j_dam, storage volume [m3], constant discharge [m3/s]

L e e e e e e e e e e e e e e e e e (M M e M M (M M M 2 e 1
@ Activate the dam model by setting flag 1 on L65 and specify the dam file name on L66 in

RRI_Input.txt.
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